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This section covers the new Microsoft® Office 2004 for Mac features that are the most relevant 
for administrators, information technology (IT) professionals, and support staff. 

Office shared features 
Administrators and support professionals will want to review some of the new features that are 
available in Office 2004 for Mac in order to ensure that users do not experience any loss of work 
time or data.  

Project Center 
Microsoft Office 2004 introduces the Project Center, which provides a single, consolidated view of all 
information related to a project. Project Center projects are created by using Microsoft Entourage® 
and also can be used in Microsoft Word, Microsoft Excel, or Microsoft PowerPoint® by using the 
Project Palette. 

Project Center projects consolidate all the e-mail, contacts, Calendar events, notes, tasks, Office 
documents (including document property information and attachments), other program documents 
(local and remote), and Scrapbook clips associated with the project.  
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The Project Center creates Project Watch Folders for Entourage messages and documents. An item 
is considered part of a project if it is designated as such in Entourage or if an alias to a program 
document is located in one of the designated Project Watch Folders. Users can flag any Entourage 
message, Calendar event, task, note, or contact as a project item. Scrapbook clips and documents 
created by using Office 2004 programs and other programs can also be added to projects. 

Users can invite other Entourage 2004 users to share project information by using a mutually 
accessible network server or by storing project information in a shared folder on the computer. Each 
subscriber to a project can make changes to project data and control what is shared with others. 
Users can back up all or part of the project, and can import the information again later.  

After a project is created in the Project Center in Entourage, the Project Palette (available in Word, 
Excel, and PowerPoint) can be used to schedule and view project events, write notes, and create new 
tasks. When a user creates a task or schedules an event by using the Project Palette, the information 
also appears on the Calendar or Tasks list in Entourage. 

Location of project files 

Microsoft Entourage creates two Project Watch Folders for each project. Entourage then keeps track 
of the items added, changed, or deleted from these folders and automatically associates them with 
the project. Administrators will want to encourage users to back up projects periodically to maintain 
a record of what items were associated with a project, as well as their original locations. 

The Entourage Project Watch Folder stores e-mail messages. When an e-mail message is moved or 
copied to the Entourage Project Watch Folder, it is automatically associated with the project. Users can 
also use rules (on the Tools menu in Entourage) to flag messages as part of the project without 
moving or copying the messages. 

The Finder Project Watch Folder contains documents and aliases (shortcuts) to documents. These 
documents and aliases are automatically associated with a project. Any documents that are added to 
projects in Microsoft Office programs are added to the Finder Project Watch Folder as aliases. They 
are not moved or copied. The original versions of documents are stored in the Finder Project Watch 
Folder only if the user placed them there manually. When a document is manually moved into the 
Finder Project Watch Folder, it is automatically associated with the project. 

Subfolders can be added to a Project Watch Folder to further organize project documents. The folder 
hierarchy in the Finder Project Watch Folder is also displayed in Entourage in the Project Center on the 
Files tab. 

By default, the Finder Project Watch Folder is stored in the Documents/Office Projects/Project Name 
folder. Users can also create an alias to the folder on the desktop. 

Finder Project Watch Folders can be stored on a network server and shared. If a project is shared and 
a document in that project is shared, it is always moved to the shared folder location on the file server. 
Users can access shared files only when they are connected to the file server. Administrators will need 
to recommend and monitor the file servers used to store Finder Project Watch Folders. Support 
professionals troubleshooting lost project data will want to verify that the Finder Project Watch Folders 
on the share have not been deleted or moved. 
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Shared project access 
When a project is shared, a shared folder is created on the file server. Any shared files are moved to 
the shared folder. Shared files are accessible only to users that are connected to the file server. After 
the administrator identifies a location for storing shared project data, he or she should obtain a list of 
the project subscribers and ensure that only those people who need access to project data are 
allowed access to the file server.  

Shared projects rely on the permissions of the folder where they are stored to prevent unauthorized 
access. Any individual with read access to the folder where the project is stored can view the contents 
of the project. This might expose confidential information to those who are not invited to join the 
project. To maintain the security of project data, be sure that the project's folder permissions limit 
access to members of the project. Anyone can forward a project invitation to others, which notifies 
them of the project's location if the recipient is an Entourage 2004 user. However, the project 
originator might not want them to join the project. Appropriately designating the project's file 
permissions helps prevent problems like this from occurring. 

For the latest information about known issues in Microsoft Entourage 2004 for Mac, visit the Microsoft 
Support Web site at http://www.microsoft.com/mac/. 

Compatibility Report 
Compatibility Report identifies and helps fix items in a document that might not be displayed or 
printed properly in earlier versions of Office for Mac or in versions of Office for Windows®. Users who 
share documents with users of other versions of Office can use Compatibility Report to ensure that 
documents look as desired when they are opened. Compatibility Report can be used in Word, Excel, 
and PowerPoint by clicking Compatibility Report on the Tools menu. 

Administrators and support professionals can use Compatibility Report to help prevent or diagnose 
compatibility issues if their users are using documents created by different versions of Office. 

Office Toolbox 
The Office Toolbox in Office 2004 for Mac provides Encarta and MSN search functionality, which 
requires a constant Internet connection for users to take full advantage of the functionality of the 
tools. Administrators will want to ensure that a constant Internet connection is maintained or that 
users without a constant connection are made aware of the limited functionality of the Office Toolbox. 

File recovery 
Office 2004 for Mac provides a new file recovery feature that saves a copy of a working document 
every 10 minutes by default, so that if a user loses power or an Office program stops responding, a 
previously saved or recovered version of the file is available the next time the program is opened. 
Administrators and support professionals can use this feature to assist users in file recovery.  

http://go.microsoft.com/fwlink/?LinkId=18214&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=18214&clcid=0x409
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Enhanced Unicode support 
Office 2004 for Mac can use a wider range of languages than previous versions of Office. Enhanced 
Unicode character support allows for non-roman characters. Office displays, prints, and accepts input 
of a wide variety of Unicode characters, both from the Basic Multilingual Plane and the Supplementary 
Unicode Planes. In addition, Office now fully supports 255-character long file names, which can also 
include Unicode characters. 

AutoUpdate 
AutoUpdate automatically searches Microsoft servers for the latest version of Office 2004. Support 
professionals can diagnose problems by investigating whether AutoUpdate has been disabled. 
Administrators will want to establish a protocol that asserts whether users install the updates 
immediately, install them later, or ignore them.  

Error Reporting 
Office 2004 Error Reporting is a new method to let Microsoft know about potential program problems. 
If an Office program stops responding, a report is generated that details the circumstances. Users can 
choose whether or not to send this report to Microsoft. Users also have the option to restart the 
program automatically, making it easier for them to get back to work. Administrators will want to 
decide whether or not their users should send error reporting data to Microsoft. 

Improved AppleScript support 
Office 2004 now supports a full, native AppleScript dictionary, enabling AppleScript developers to 
write scripts that can control Office programs without the additional use of Visual Basic for 
Applications (VBA). For more information, see the Microsoft Web site at 
http://www.microsoft.com/mac/. 

Microsoft Entourage 2004 
The following new features and enhancements are available in Entourage 2004 for Mac. 

Junk E-mail Protection 
Entourage 2004 for Mac Junk E-mail Protection identifies and filters out more unwanted messages 
than previous versions of Entourage. Junk E-mail Protection is set to low by default, but users can 
choose from different levels and options to determine the level of protection that is desired. 
Administrators may want to set a required Junk E-mail Protection level for all users in their network to 
contribute to a consistent protection level and a more predictable message volume on the network. 

http://go.microsoft.com/fwlink/?LinkId=22207&clcid=0x409
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Archiving 
Users can archive mail, tasks, contacts, Calendar events, and notes in a single package that they can 
save and access later. In addition, users can also archive Project Center information. Administrators 
may want to set up a specific network server for users to store archives. 

Messenger for Mac integration 
Messenger for Mac is integrated into Office 2004 for Mac and provides instant message and contact 
functionality to programs such as Word and Entourage. Administrators may want to set standard 
Messenger settings for all network users to ensure that instant message communication follows 
company privacy practices.  

Entourage Setup Assistant 
The Entourage Setup Assistant walks users through the account setup process step by step and helps 
to configure e-mail accounts automatically so that users can begin using Entourage without entering a 
lot of information. Administrators will find that Entourage 2004 mail account setup requires less 
administration than previous versions of Entourage for Mac. For Exchange mail accounts, 
administrators should ensure that clients can use DNS to resolve the domain name of the Active 
Directory domain where the user account is stored and that clients can use LDAP to query an Active 
Directory domain controller for the domain. 

Exchange Server support improvements 
Enterprises can use Entourage 2004 for Mac to access Exchange server information. All Entourage 
messages are continually and automatically synchronized with the information on the Exchange 
server. The new Account Setup Assistant makes setting up an e-mail account easier for users and 
verifies settings on their behalf. 

Entourage supports the following Exchange server features: 

• Delegation access    Users can delegate the management of their mail, Calendar events, and 
Address Book contacts to someone else.  

• Public Folders    Users can subscribe to and create their own Exchange server public folders.  

• Sharing    Users can share Address Books, Calendars, and Mail  folders with other Exchange 
users.  

• Multiple Address Books, Calendars, and Mail folders    Users can create multiple Address 
Books, Calendars, and Mail folders on the Exchange server by using Entourage.  

Message security 
Users can use encryption to protect the contents of the messages they send. They can also use digital 
ID signatures to assure message recipients that the message is really from them and to verify the 
sender of signed messages they receive. 
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Virtual PC for Mac 7.0 
Office 2004 for Mac ships with Virtual PC for Mac 7.0. Administrators supporting cross-platform 
computer users may want to deploy Virtual PC for Mac in their network. Virtual PC for Mac supports 
the following operating systems: Windows XP Professional, Windows XP Home Edition, and Windows 
2000 Professional. Refer to the Read Me file for specific details about the supported operating 
systems. The Read Me file is included on the Virtual PC 7 installation CD and in Virtual PC on the 
Help menu. 

Licensing Office 2004 for Mac 
As outlined in the Microsoft Office End-User License Agreement, users can install and use one copy of 
Microsoft Office 2004 on a single computer. If a user is the primary user of that computer, the user 
can also install a second copy of Office, for his or her exclusive use, on a portable computer, as long 
as that computer is not connected to the same network as the computer with the primary copy. 

Note   If users install the same copy of Office 2004 on more than one computer and exceed the 
number of installations permitted by your organization's license agreement, the Office programs will 
automatically quit shortly after being started. Before quitting, the user will have an opportunity to save 
changes that they have made to any open documents. 

To install Office 2004 on additional computers, your organization can purchase additional copies of 
Office through your Microsoft reseller or purchase a volume license through the Microsoft Volume 
Licensing program. 

• Retail purchase   If your organization needs fewer than five copies of Office, purchase each 
copy through your Microsoft reseller. 

• Volume licenses   By participating in the Microsoft Volume Licensing program, you can 
purchase a volume license for five or more copies of Office. For information about this 
program, visit the Microsoft Licensing Web site at http://www.microsoft.com/licensing/. 

To determine which licensing option best meets your needs or to purchase a volume license, contact 
your Microsoft reseller. If you do not yet have a relationship with a Microsoft reseller, the Microsoft 
office for your region can help you find one. For information about contacting your regional Microsoft 
office, visit the Microsoft Worldwide Information Web site at http://www.microsoft.com/worldwide/. 

http://www.microsoft.com/licensing/
http://www.microsoft.com/worldwide/
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This section provides information you should know before using Microsoft Office 2004 for Mac. 

System requirements 
To run Microsoft Office 2004, the user’s computer must meet the following minimum requirements: 

• Processor: Mac OS X-compatible processor that is a model G3 or higher.  

• Operating System: Mac OS X version 10.2.8 or later.  

• Memory: 256 MB of RAM.  

• Hard Disk: 570 MB of available hard-disk space for installing Office by using the Office Setup 
Assistant (recommended); 610 MB for installing Office by dragging the Microsoft Office 2004 
folder to the hard disk.  
 
The hard disk should be in Mac OS Extended (HFS+) format, the default format for Mac OS X. 
Although you can use drag-and-drop installation to install Office 2004 on a hard disk that is in 
another format, Microsoft does not currently support such a configuration. To determine the 
format of the hard disk, on the Apple menu, click About This Mac, and then click More Info. 

• Drive: CD-ROM drive.  

• Display: Monitor that can display 1024 x 768 or higher resolution with thousands of colors.  

To use all of the features available in Office 2004, we recommend that users have the following 
additional items and services: 

• Modem: 14.4 Kbps or faster.  

• Internet Access: Internet access (for Microsoft Entourage and certain features in other Office 
programs). Internet access might require paying a separate fee to a service provider; local 
and/or long-distance telephone charges might apply. 
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Upgrading to Microsoft Office 2004 for Mac 
The following information will assist you in determining the eligibility of your clients for upgrading to 
Microsoft Office 2004 for Mac. This section also provides information about some of the existing 
upgrade issues. 

Upgrade eligibility 
Users can upgrade to Microsoft Office 2004 if they are licensed users of any of the following Microsoft 
products: 

• Office 98  

• Office 2001  

• Office v. X (all editions)  

• Word + Entourage 2001, Special Edition  

• Word 98  

• Word 2001  

• Word X  

• Word 2004  

• Excel 98  

• Excel 2001  

• Excel X  

• Excel 2004  

• PowerPoint 98  

• PowerPoint 2001  

• PowerPoint X  

• PowerPoint 2004  
 

Those without licenses for any of the preceding products must purchase and install the full version of 
Office 2004 to use it. 

Installing the upgrade 
During installation, the Office Setup Assistant might prompt the user to select the location of the folder 
that contains an upgrade-eligible product (the Microsoft Office X folder, for example) if it cannot find it 
automatically. If the folder is not currently on the hard disk, the user is prompted on first launch of 
Office 2004 to locate it. If the upgrade-eligible product is on the original installation CD-ROM of that 
product, the user must insert the CD into the computer and select the CD-ROM location when 
prompted. 
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Importing contact information to Microsoft Office 2004 
If a user previously used Microsoft Outlook Express 5.0, Microsoft Entourage 2001, or Microsoft 
Entourage X, and he or she has identity data on the computer, the user can import one of these 
identities for use in Entourage 2004 during step 3 of the Office Setup Assistant. 

An identity stores a person's preferences, account settings, Address Book and Calendar information, 
schedules, tasks, messages, and more. The user can choose to import a previous identity or create a 
new identity. After installing Office 2004, the user can then choose to import additional identities by 
using Entourage 2004. 

If the user is not importing an identity from a previous version of Entourage or Outlook Express for 
Macintosh, the user needs to create a new identity, whichis used throughout the Office 2004 
programs. The user must enter at least his or her first and last name. This information is not sent to 
Microsoft. 

If users do not import identity information from a previous Office product during setup, they can import 
it after they install Office 2004. To do so, they can open Entourage, click Import on the File menu, and 
then follow the instructions in the Import Assistant. 

Installing Microsoft Office 2004 
Important  If users have the Office v. X Test Drive or the Office 2004 Test Drive installed on their 
computers, they must first remove the Microsoft Office X or Microsoft Office 2004 folder that was 
installed with the Test Drive before installing the full version of Office 2004. In addition, administrators 
deploying Office 2004 for Mac across the network need to determine whether their network users 
have either Test Drive version installed on their computers and remove the Test Drive. 

To remove the Test Drive 

Do one of the following: 

• To remove the Office v. X Test Drive, run the Remove Test Drive application. 

• To remove the Office 2004 Test Drive, run the Remove Office application.  

All Microsoft Office 2004 components can be installed at once, or the user can select individual 
components. The Office Setup Assistant provides guidance for installing Office in six easy steps: 

1. Welcome  

2. License Agreement  

3. User Information  

4. Product Key  

5. Installation  

6. Getting Started  
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Notes 

• Before installing Office 2004, turn off virus-protection software because it might interfere with 
installation, and quit any programs that are running. 

• If the computer is currently running the Classic environment (Mac OS 9), switch to Mac OS X. 
To quit the Classic environment, on the Apple menu, click System Preferences, and then 
click Classic. On the Start/Stop tab, click Stop.  

• Make sure that the Mac OS X user account has administrator privileges. (A user must know 
both the user name and password for this account.) To check the user account for 
administrator privileges, on the Apple menu, click System Preferences, and then click 
Accounts. User accounts with administrator privileges have the word "Admin" beside them. 
For more information about Admin accounts, see Mac Help.  

To install Microsoft Office 2004 

1. To start the Setup Assistant, insert the Microsoft Office 2004 CD-ROM into the computer's CD-
ROM drive.  

2. On the desktop, double-click the Microsoft Office 2004 icon. 

3. When the setup window appears, double-click the Office Setup Assistant icon.  

4. Follow steps 1 through 4 in the Office Setup Assistant. Be sure to read the instructions on 
each screen carefully.  
 
In the Authenticate window, enter an administrator user name and password. If the Setup 
Assistant becomes idle during any point in the setup process, a prompt might appear for the 
user name and password. 

5. In step 5 of the Setup Assistant (Installation), under Select the installation location, on the 
pop-up menu, click the location to install Office.  

6. Under Select the type of installation you want, most people will want the Recommended 
(default) installation. To install only certain components, click Custom, and then select the 
check boxes for the components you want.  
 
Note   Clearing the check box next to a component in the Setup Assistant does not remove 
the component if Office 2004 was previously installed. 

7. Click Install. 

Known issues in Office 2004 for Mac 
For information about known issues in products that are part of the Office 2004 for Mac suite, see the 
Read Me document accompanying each product. 
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This section provides details about the security features available to Microsoft Office 2004 for Mac 
users. Administrators supporting Office 2004 can use their knowledge of these features to: 

• Instruct users about how to protect their information 

• Assess the security of networks and systems 

User information 
Microsoft Office shares the personal information that users enter during setup with all Office programs 
that are installed on the computer. Users and administrators should both be familiar with the user 
information that accompanies Office documents, so they can ensure that privacy is maintained. In 
particular, administrators responsible for corporate security should understand how the information is 
stored in Office programs and which program features might need to be administered to maintain this 
privacy. 

Office programs use the information to personalize the output of certain features. For example, 
Microsoft Word, Microsoft Excel, and Microsoft PowerPoint add a user name and a company name to 
the Summary tab in the Properties dialog box (File menu) and a user name to label comments and 
revision marks. Word uses this information to generate a return address on envelopes and labels and 
in the wizards used to help create letters and other kinds of documents. Word also uses this 
information when a user opens the business templates in the Project Gallery. Excel uses this 
information to create custom headers and footers that contain a user name or company name. 

With Microsoft Entourage installed on a computer, the identity that is currently active in Entourage 
determines whose user information appears in the other Office programs. In Entourage, users can 
create multiple identities, making it easier to share one computer with a number of people. To ensure 
that Office programs use the correct information, a user must log on to the computer by using his or 
her own logon information, or the user must switch identities in Entourage. 

The user is not required to enter a password to switch identities in Entourage, but identities are stored 
as part of a Mac OS user account. To ensure that identity information is accessible only by the 
authorized user, users must not share their Mac OS user account with other users.  

Administrators can instruct users to update or remove personal contact information in the following 
ways: 

• In Word, on the Word menu, click Preferences, and then click User Information.  

• In Excel, on the Excel menu, click Preferences, and then click General.  

• In PowerPoint, on the PowerPoint menu, click Preferences, and then click Advanced.  

• In Entourage, click Address Book, double-click the contact that appears with the Contact is 
Me symbol next to it, and then click the tabs that contain the information to change. This 
information is then automatically updated in the other Office programs. 
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Identities 
An identity stores a person's preferences, account settings, Project Center information, Address Book 
and Calendar information, schedules, tasks, messages, and more. An identity can also store personal 
information, such as a person's e-mail address and street address, once this information has been 
entered as a contact and the contact has been marked as Contact is Me. If more than one person 
uses Microsoft Entourage on the same computer, users can set up separate identities so that each 
person can configure Entourage to reflect his or her own preferences. This feature ensures that each 
person sees only his or her own messages, Calendar events, and other items, without logging on to the 
computer as a separate user. Administrators who support multiple users on a single computer might 
need to show users how to use identities to protect the privacy of their communications.  

The data for each identity is stored in the Documents/Microsoft User Data/Office 2004 Identities 
folder. 

Users can switch identities at any time (Entourage menu, Switch Identity command). When users 
switch identities, the Entourage window closes, and users can choose a different identity in the dialog 
box that appears. Users can display this dialog box automatically each time Entourage starts, so that 
each person can choose an identity when he or she begins using Entourage. When an identity is in 
use, it is called the "active identity." 

Identities in other Office programs 

In addition to storing personal information and Entourage settings, other Office programs use 
identities to customize specific features. In Word, Excel, and PowerPoint, the active identity 
determines the author of a document. The active identity also determines which contact information 
appears in documents created by using templates, such as in the return address for a letter created in 
Word. Because a user can flag and receive a reminder to follow up on any Office document, identities 
also ensure that each person receives reminders only for his or her own documents. 

Administrators can choose to recommend the practice of editing or removing the author and contact 
information that appears in documents created by using templates. This practice will help ensure that 
a level of privacy exists in all documents sent outside the corporate environment. 
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Relationship with Mac OS user account 

Identities are stored as part of a Mac OS user account. The security of the identity is dependent on the 
security features of the Mac OS user account password. Mac OS X uses four main types of passwords: 

• User account password   User account passwords allow users to log in to their home folders. 
This is often referred to as a "login password." 

• Administrator password   Administrator passwords are needed before the administrator can 
perform many tasks on the computer, including setting system preferences, installing 
software, and administering user accounts. An administrator password is an administrator 
user's login password. 

• Master password   The master password is a computer-wide password set up by an 
administrator as a safeguard in case the administrator forgets his or her login password. The 
master password is usually used in conjunction with FileVault, a way of encrypting a user's 
home folder so that it cannot be seen by anyone but that user. If a FileVault user forgets his or 
her login password, even an administrator cannot log in to the user's account with an 
administrator password. Only the master password can override a FileVault user's password. 

• Keychain password   The keychain stores passwords for various applications and resources 
on the computer. The keychain password "unlocks" the keychain so that the passwords inside 
it can be used. The keychain password is the same as the login password when the account is 
first set up. 

Users can use the keychain to store passwords that access servers, secure Web sites, shared folders, 
and password-protected documents. Additional keychains can be created with passwords that are 
different from the login keychain and login password. If a user forgets the password to these 
keychains, neither the user nor an administrator can access them. 

For more information about Mac OS passwords, see Mac Help. 

Macro viruses 
This section discusses how Office 2004 is protected from macro viruses. By understanding the macro 
virus prevention options available, administrators can help their Office 2004 users prevent macro 
virus infections. 

Microsoft Office does not scan a floppy disk, hard disk, removable media, or network drive to find and 
remove macro viruses. For this kind of protection, administrators will need to purchase and install 
antivirus software. However, by default, Office displays a warning message whenever a user opens a 
document that contains macros. Users can then decide whether to open the document with the 
macros enabled or to disable the macros so that they can be only viewed and edited. If a user disables 
macros, then the macros will not be displayed and the document will be read-only. A macro virus can 
be harmful only if it is allowed to run, so disabling the macros allows users to open the document 
safely. 
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If users expect documents to contain useful macros, they can click Enable Macros to open the 
document with the macros enabled.  

If users do not expect the document to contain macros, or do not know or are not certain about the 
reliability of the document’s source, they should click Disable Macros to open the document with 
macros disabled. For example, a user might notify an administrator that he or she received a 
document as an attachment to an e-mail message from an unfamiliar source or from a network or 
Internet site that is not secure. In these cases, administrators can talk to the document’s originator to 
verify that it is free of viruses, or instruct the user to click Disable Macros.  

Using documents that contain digitally signed macros 
Microsoft Word 2004 does not recognize digital signatures, so it cannot update the signature if a user 
modifies a signed Microsoft Visual Basic® for Applications macro. Therefore, to prevent modifications, 
users cannot view in Word 2004 the code for macros that have been digitally signed in Word 2000, 
Word X, or Word 2003 for Microsoft Windows. 

Turning on or off macro virus protection 
To prevent the possibility that macros containing viruses might contaminate the system, Microsoft 
Office displays a warning message when users try to open a document that contains a macro. This 
message appears regardless of whether the macro actually contains a virus. Users should make sure 
that they know and trust the source of the document before opening the document.  

To turn on or off macro virus protection 

1. On the Application (Word or Excel) menu, click Preferences, and then click Security.  

2. Select or clear the Warn before opening a file that contains macros check box.  

Note   If a user disables macro virus protection, he or she runs the risk of the computer being infected 
by a virus, which could result in serious damage to data. 

Macro security troubleshooting 
The following troubleshooting scenarios provide information about how to resolve the most common 
macro security issues. 

• User cannot use a macro in a document or add-in program that he or she opened 

The user might have chosen to disable macros when opening the document. To run the 
macros, instruct the user to close and then reopen the document or unload and reload the 
add-in program, and then click Enable Macros. 

• User cannot view the macros in a document or add-in program 

The macros might have been digitally signed from within the Visual Basic Editor in Office for 
Windows. Office 2004 for Mac does not recognize digital signatures in macros, so it cannot 
update the signature if a user modifies a signed Visual Basic for Applications macro. Users 
cannot view in Office 2004 the code for macros that have been digitally signed in Office for 
Windows. 
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• Users keep getting a warning about macros 

The document might contain a macro. If the user does not expect the document to contain a 
macro, it’s possible that a macro has introduced a virus into the document. Check the 
computer for viruses, and then try to get an uninfected copy of the document from the source. 

The macro might be in a file that the user downloaded as an HTML page from a Web site and 
opened as a temporary file. If the virus scanner reports that it has removed a virus in this file 
every time the user opens it, the user is removing the virus from the temporary file only and 
not from the original file on the Web server. Check the computer for viruses, and then notify 
the source about problems with the original file. 

• The document contains legitimate macros 

Microsoft Office cannot distinguish between safe and unsafe macros. Users can turn off 
macro virus protection if they no longer want to see these messages. 

Passwords 
Office 2004 provides password protection features for Word and Excel documents. To improve privacy, 
administrators can recommend that users employ the password features of Word when sharing 
documents that contain sensitive information. For Excel, it is important that administrators inform 
users that the password protection feature of Excel is not intended to be used to secure or protect 
data, but merely to improve privacy.  

Password protection is not intended to be a high-level security feature in Office 2004 and does not 
provide the protection available from digital certificates and other security options. 

Word password protection 
In Microsoft Word, passwords have a number of uses. A password can contain any combination of 
letters, numerals, spaces, and symbols, and it can be up to 15 characters long. Passwords are case-
sensitive. If users vary the capitalization when they assign the password, they must type the same 
capitalization when they enter the password. For more information, see Security Features in Word on 
page 31. 

Excel password protection 
The features in Microsoft Excel for hiding data and protecting worksheets and workbooks by using 
passwords are not intended to be used as ways to secure data or protect confidential information. 
However, administrators can recommend that these features be used for other reasons—typically, to 
present information more clearly by hiding data or formulas that might confuse some users, and to 
help prevent the wrong user from making an accidental change to workbook data. Excel does not 
encrypt the data that is hidden or locked in a workbook, which means that given sufficient time and 
knowledge, any user can obtain and modify any of the data in any workbook he or she has access to. 
To help prevent this, and to help protect confidential information, administrators can limit access to 
any Excel files by storing them in locations available only to authorized users. 
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Users can protect separate elements within a worksheet, protect an entire worksheet, or protect an 
entire workbook. They can also use passwords to restrict access to an entire workbook or to restrict 
users to read-only access of a workbook. 

Entourage message security 
Microsoft Entourage 2004 provides many security features to keep sent and received messages safe. 
By knowing about the security features in Entourage, administrators can recommend and support 
these features and ensure that sensitive information is protected. Administrators will also want to be 
familiar with the following security features if they are evaluating the overall security of the corporate 
infrastructure. 

Secure message contents   Encryption protects the contents of the sent messages. 

Verified senders   Digital ID signatures verify the sender of signed messages.  

Virus protection   By default, Entourage alerts users of potential virus activity before it can 
damage a user’s computer or spread to other computers. For example, message attachments are 
a common way for computer viruses to be spread. Opening an attachment that contains a virus 
could result in data loss. Entourage alerts users each time an attachment is included in a 
message and gives them a choice of whether or not to open the attachment. 

Internet connection security   Internet service providers and internal networks offer different 
levels of protection based on a variety of protocols, such as Secure Sockets Layer (SSL), SMTP 
authentication, and password protection. The security features available to users depend on the 
connection type. By knowing the connection types available, network administrators can regulate 
which security features are employed. 

Encryption, digital IDs, and certificates 
Entourage provides two ways to protect the privacy of messages: 

• Encryption, which makes the message unreadable to anyone other than the intended 
recipient. 

When users send messages that are encrypted, each message must be encrypted using a 
certificate (public key) for each recipient. Users must also encrypt messages for themselves 
so that they can read the messages once they are sent or saved in the Drafts folder. The 
recipient will be able to read encrypted messages because the messages contain information 
that matches the private key stored on the recipient's computer. A user can obtain certificates 
by receiving digitally signed messages from others and storing their certificates in the 
Entourage Address Book.  
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• Digital signatures, which assure the message recipient of the sender’s identity. 

When a digitally signed message is sent, the message signature contains the issuer name 
and a serial number that uniquely identifies the digital identity used to sign the message. The 
message also includes the certificate (public key) and the validation chain (chain of trust). The 
recipient uses this certificate to verify which private key was used to sign the message. The 
recipient can also store the certificate in a contact list so that he or she will always be able to 
verify digitally signed messages from the user.  

Administrators can choose to deploy either method or both methods for any message. Encryption and 
digital signing are most often used by corporations or government agencies that have a heightened 
security standard. 

Before users can digitally sign or encrypt a message, they must obtain a digital ID. Users can store and 
use more than one digital ID on their computers.  

Administrators deploying digital signatures will need to set up network computers with a digital ID or 
provide instructions to users on how to configure the digital ID themselves. To get an Internet digital 
ID, users must obtain one from a certification authority. Most companies charge a small fee for their 
certificate services. 

Microsoft Cert Manager 

Users or administrators can use the Microsoft Cert Manager to import and export digital IDs and to 
view all of the digital IDs stored on a computer. 

To open the Microsoft Cert Manager, double-click Microsoft Cert Manager, located in the Microsoft 
Office 2004/Office folder. 

Importing certificates (other than root certificates) 

To import a certificate or digital ID 

1. Double-click Microsoft Cert Manager, located in the Microsoft Office 2004/Office folder.  

2. Click Import.  

3. In the Import Certificate dialog box, click the certificate or digital ID to import, and then click 
Open.  
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Importing root certificates 

A root certificate is a self-signed certification authority (CA) that identifies a CA and its public key. It is 
used to verify other certificates that are issued by the same CA. The root is stored in a secure location 
on a computer and is used to verify the authenticity of all certificates in use. 

Macintosh computers have a default set of standard root certificates that are trusted, but 
administrators may need to install additional root certificates to verify certificates that are issued by 
non-standard CAs, such as corporations or universities. 

To install a root certificate on the computer, the certificate must be in base-64 format (for Mac OS 
10.2.8 and greater), and the person installing the root certificate must have administrative privileges. 
If the root certificate is not in the correct format, use the Microsoft Cert Manager (located in the 
Microsoft Office 2004/Office folder) to convert it. 

How to install a root certificate depends on which Mac OS version is running. If the computer is 
running a version other than the ones listed here, check the documentation that came with the 
computer for information about how to install a root certificate. Always restart Microsoft Entourage 
after installing new root certificates. 

To install a root certificate on Mac OS 10.2.8 

1. Copy the PEM (base-64) formatted root certificate to the computer's desktop.  

2. In Terminal, type the following:  

$ cd ~/Desktop  

$ cp /System/Library/Keychains/X509Anchors ~/Library/Keychains  

$ certtool i <filename_of_certificate> k=X509Anchors  

$ sudo cp ~/Library/Keychains/X509Anchors /System/Library/Keychains/  

<Enter the root password>  

To install a root certificate on Mac OS 10.3 or 10.4 

1. Open the Applications/Utilities folder on the computer and locate the Keychain Access 
application. You do not need to start Keychain Access. 

2. Drag the root certificate to the Keychain Access application. Root certificates must be 
installed one at a time.  

3. In the Add Certificates dialog box, click X509 Anchors, and then click OK. 
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Exporting certificates 

To export a certificate 

1. Do one of the following:  

• To export a contact's certificate, in the Address Book, open the contact, and then click the 
Certificates tab.  

• To export your own certificate, start the Microsoft Cert Manager (located in the Microsoft 
Office 2004/Office folder).  

2. Select the certificate you want to export, and then click Export.  

3. In the Save As box, type a name for the certificate.  

4. On the Format pop-up menu, click a format.  

5. Do one of the following: 

• If the application you are planning to import this certificate into requires certificates to be 
in binary format, click DER. 

• If the application requires a base-64 encoded format, click PEM.  

6. In the Where box, select a location.  

7. To include all of the certificates used to verify the authenticity of the certificate you are 
exporting, select the Include all certificates in the certification path check box.  

8. Click Save. 

Default secure message settings 
Administrators usually will want to review the default secure message settings for Entourage 2004 
and, if appropriate, change these settings for their network clients. Typically, administrators deploy the 
same security settings across all network clients to ensure a consistent security infrastructure. 
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To change the default secure message settings 

1. On the Tools menu, click Accounts.  

2. Select the mail account you want to change, and then click Edit.  

3. Click the Security tab.  

4. Select the options you want: 

Option Description 

Signing certificate Click Select and choose a certificate to use for digitally signing 
messages from this account.  

If no certificates are available, you need to obtain one from a 
certification authority. To view a list of certification authorities, see 
Where to Get Your Digital ID on the Microsoft Web site. 

Digitally sign all outgoing 
messages by default 

Select to digitally sign all outgoing messages using the specified 
certificate by default. This option can be turned on or off for individual 
messages. 

Include my certificate when 
sending signed messages 

Select to include your signing certificate when sending signed 
messages. The validation chain (chain of trust) and encryption 
certificate will also be included. The message recipient will use the 
information in the certificate to validate the authenticity of the 
message. 

Send clear text signed 
messages when sending 
signed messages 

Select to allow recipients using e-mail programs that don't support 
secure messages (S/MIME) to read the message.  

If you clear this option, the certificate information will be embedded in 
the message and only those with e-mail programs that support secure 
messages will be able to read the message. 

Encryption Certificate Click Select, and then click the default certificate others will use to 
send encrypted messages to this account. This certificate will also be 
used to encrypt messages that are saved in the Drafts or Sent Items 
folders in Microsoft Entourage, which allows you to review encrypted 
messages even after you send them.  

If no certificates are available, you need to obtain one from a certifying 
authority. To view a list of certification authorities, see Where to Get 
Your Digital ID on the Microsoft Web site. 

http://go.microsoft.com/fwlink/?linkid=20548&clcid=0x409
http://go.microsoft.com/fwlink/?linkid=20548&clcid=0x409
http://go.microsoft.com/fwlink/?linkid=20548&clcid=0x409
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Option Description 

Encrypt contents and 
attachments for all outgoing 
messages by default 

Select to encrypt all outgoing messages by default. The message will 
be encrypted with each recipient’s encryption certificate as well as the 
encryption certificate you specified earlier. This option can be turned 
on or off for individual messages. 

 

Receiving a secure mail message 
When a user opens an encrypted message, Entourage automatically decrypts the message. When a 
user opens a digitally signed message, Entourage uses the attached certificate (public key) to validate 
the private key used to digitally sign the message and determine that no forgery or false 
representation has occurred. A summary of the security information Entourage is able to determine is 
displayed in the Info Bar at the top of the message.  

The following table describes the security information Entourage displays in the Info Bar. 

Item Description 

Message has not been 
tampered with 

No information in the message body has been added, changed, or deleted.

You trust the signing 
digital ID 

The Mac OS comes with 50 or more trusted certificates that are used as 
root certificates for building others. The signing digital ID for the message 
uses a certificate that can be traced back to a trusted root certificate 
installed on your Macintosh. 

The digital ID has not 
expired 

The Mac OS system clock must be set to the correct date and time for this 
information to be valid. 

The digital ID's e-mail 
address matches the 
sender's 

The e-mail address in the certificate used to sign or encrypt the message 
matches the mail account from which the message was sent (and for 
which it was meant to be used). If the addresses do not match, the 
message will still be considered valid. 

The digital ID has not 
been revoked 

Entourage was able to check information provided by the certifying 
authority and determine that the certificate has not been revoked. 

Revocation information 
for this certificate could 
not be determined 

Entourage could not find any information issued by the certifying authority 
on revocation status for this digital ID. 
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Notes 

• A message is digitally signed when the sender has applied his or her private key to the 
message.  

• If a delegate sent the message on behalf of another person, the delegate's name appears as 
the sender. 

Viewing or deleting a certificate 
You can view or delete any certificate that you added. You cannot delete Apple Trusted Root Certificate 
Authorities, because they are part of the Mac OS. 

To view or delete a certificate 

1. Double-click Microsoft Cert Manager, located in the Microsoft Office 2004/Office folder.  

2. On the Look for certificates of type pop-up menu, click the type of certificate you are looking 
for.  

3. In the list of certificates, click the certificate you want to view or delete, and then click View or 
Delete.  

Adding a sender's certificate to the Address Book 
Administrators might want to inform users that they can add a sender’s certificate to the Address Book 
to improve the certificate verification process. 

To add a sender’s certificate to the Address Book 

1. Open a message that has been digitally signed.  

2. In the Info Bar at the top of the message, click View Details.  

3. On the General tab, click Add to Contacts.  

The certificate is stored with the contact entry for this sender. The user can now send encrypted e-mail 
messages to this person, and the user can choose whether to encrypt an individual message or all 
messages. 

Tips 

• If a user receives a certificate by another method, such as via a message attachment or on a 
disk, it can be added to the contact entry by opening the contact in the Address Book, clicking 
the Certificates tab, and then clicking Import.  

• To view the certificates for a contact, in the Address Book, double-click the person's name, 
and then click the Certificates tab. 
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Enabling or disabling SSL 
If you use Secure Sockets Layer (SSL) with Entourage, all of the information contained in a message, 
including the body, is encrypted. This ensures that no one can intercept and read the messages of 
your network users.  

For network users to use SSL, the Exchange account administrator will want to provide SSL setup 
information to users before they set up their mail accounts. Users can also change their accounts to 
use SSL after setup.  

Note   If there are exceptions to SSL deployment with Entourage, it is important that the administrator 
keep track of the users who are not using SSL. 

If you set up an SSL connection for your network users, you might need to use a different SMTP port 
for sending messages in addition to a different POP or IMAP port for receiving messages. This option is 
not available for Hotmail accounts. 

If you have deployed SSL for your Entourage users and SSL is disabled on the Exchange Server, users 
might not be able to send or receive messages. Confirming that the SSL options are enabled on the 
Exchange Server is a useful diagnostic procedure. 

To enable the SSL options in Entourage   

1. On the Tools menu, click Accounts.  

2. On the Mail, News, Directory Service, or Exchange tab, click the account, and then click 
Edit.  

3. Do one of the following:  

• For IMAP, POP, and News accounts, on the Account Settings tab, click Click here for 
advanced receiving options or Click here for advanced sending options, and then 
select the options you want.  

• For Exchange accounts, on the Advanced tab, select the DAV service requires secure 
connection (SSL) check box.  

• For Directory Service accounts, on the Account Settings tab, click Click here for 
advanced options, and then select the This LDAP server requires a secure connection 
(SSL) check box. 
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Enabling or disabling password protection 
Password encryption (POP and IMAP only) ensures that no one can intercept and use a password to 
send and receive messages from a user’s account. Before deploying password encryption for your 
Entourage users, you need to know whether your server accepts password encryption. If it does not, 
and users configure accounts for password encryption, they might not be able to receive messages. 

To enable or disable password protection 

1. On the Tools menu, click Accounts.  

2. On the Mail tab, click the IMAP or POP account, and then click Edit.  

3. On the Account Settings tab, click Click here for advanced receiving options, and then 
select or clear the Always use secure password check box. 

Enabling or disabling SMTP authentication 
If your POP or IMAP mail server requires SMTP authentication when users send messages, you can 
provide special logon information to users for that purpose. Users can choose whether to use the 
same account ID and password they use for receiving messages or to specify different ones. 

To enable or disable SMTP authentication 

1. On the Tools menu, click Accounts.  

2. On the Mail tab, click the IMAP or POP account, and then click Edit.  

3. On the Account Settings tab, click Click here for advanced sending options, and then 
select or clear the SMTP server requires authentication check box.  

4. If you want to specify different account ID and password information, click Log on using and 
enter your information. 
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Enabling virus notification 
The virus notification options available to your Entourage users are simple to deploy and very effective 
at providing security to your users. Also, a protocol that encourages users to notify administrators 
when these notifications appear will provide administrators with a consistent indicator of some of the 
virus activity on the network. Administrators might want to evaluate these options and recommend a 
standard configuration to all Entourage users to prevent the spread of viruses on the network. 

To view the virus protection and notification options 

1. On the Entourage menu, click Preferences.  

2. Under General Preferences, click Security.  

The following table lists the available virus protection and notification options. 

Option Description 

Warn before opening an 
attachment 

Displays a warning before you open any attachment. Attachments are a 
common way for computer viruses to be spread. Opening an 
attachment that contains a virus could result in data loss. 

Warn before allowing an 
external application to send 
mail  

Displays a warning before allowing an external application to use 
Microsoft Entourage to send mail on its behalf. Some computer viruses 
not only cause problems on the infected computer, but use the e-mail 
program on the infected computer to send the virus to others. The 
message and attached virus will look like it came from the owner of the 
infected computer. 

Warn before allowing an 
external application to access 
the address book 

Displays a warning before allowing an external application to access 
the information stored in the Entourage Address Book. Some computer 
viruses will try to find e-mail addresses stored on the infected computer 
and use these addresses to spread the virus. 

 

Authentication and security using WebDAV 
The WebDAV protocol that Entourage 2004 uses for Exchange mail accounts provides security for 
message transactions such as synchronization with the Exchange Server. For a general discussion of 
WebDAV authentication and security, see Authentication and Security Using WebDAV in the Microsoft 
MSDN library at http://msdn.microsoft.com/library/.  

http://go.microsoft.com/fwlink/?LinkId=32987&clcid=0x409
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Security features in Word 
The security and protection features Word provides can limit or restrict access to a document. 
Administrators will want to review these features with users who will be sending sensitive documents 
outside the company. The following security and protection features are available: 

• Require users to enter a password to open a document. This prevents unauthorized users 
from opening the document.  

• Require users to enter a password to modify a document. This allows only authorized users to 
make changes to the document. If someone who has not entered the password changes the 
document, that person can save the document only by giving it a different file name.  

• Have Word recommend opening a document as read-only to suggest, but not require, that 
users open a document as read-only. If a user opens the document as read-only and then 
changes it, that person can save the document only by giving it a different file name.  

• Prevent users from changing a form. For example, you could protect an online form to prevent 
unauthorized users from typing information anywhere other than in designated areas.  

• Check for macros that might contain viruses whenever the user opens a document. 

Require users to enter a password to open or modify a document 
Administrators might want to remind users that when they create a password for a Word document, 
they should write it down and keep it in a secure place. If the password is lost, the user cannot open or 
gain access to the password-protected document.  

To require users to enter a password to open or modify a document 

1. Open the document.  

2. On the File menu, click Save As.  

3. Click Options, and then click Security.  

4. Do one of the following: 

• To require users to enter a password to open a document, in the Password to open box, 
type a password, and then click OK. 

• To require users to enter a password to modify a document, in the Password to modify 
box, type a password, and then click OK. 

5. In the Confirm Password box, type the password again, and then click OK.  

6. Click Save. 
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Have Word recommend opening a document as read-only 
Administrators can suggest that users configure documents that they will be sending outside of the 
company to be opened as read-only documents. 

To have Word recommend opening a document as read-only 

1. Open the document.  

2. On the File menu, click Save As.  

3. Click Options, and then click Security.  

4. Select the Read-only recommended check box, and then click OK.  

5. Click Save. 

Prevent users from changing a form containing form fields 
After creating a form that users will view and complete in Word, the creator of the form must protect it 
so that users can enter information only in the designated areas.  

To prevent users from changing a form containing form fields 

1. On the Tools menu, click Protect Document.  

2. Click Forms.  

3. To assign a password to the form so that users who know the password can remove the 
protection and change the form, type a password in the Password (optional) box. Users who 
don't know the password can still enter information in the form fields.  

4. Do one of the following:  

• To protect the entire form, click OK.  

• To protect only parts of a form, those parts must be in separate sections. Click Sections, 
and then clear the check boxes of the sections you don't want to protect.  

Protect documents during reviews 
As part of preparing a document for review, you can specify that others can change the document only 
by inserting comments or by inserting comments and tracked changes (with revision marks). For 
added security, you can assign a password to ensure that users do not remove this type of protection. 
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To prepare copies of a document to be reviewed 

1. Open the document you want to prepare for review.  

2. Check to see whether the document contains multiple versions by clicking Versions on the 
File menu.  

3. If multiple versions exist, save the current version as a separate document with a different 
name, and use this copy as the review copy. This will prevent reviewers from opening and 
viewing previous versions of the document. 

4. On the Tools menu, click Protect Document.  

5. Do one of the following:  

• To let others change the document by inserting comments and tracked changes, make 
sure Tracked Changes is selected.  

• To let others insert only comments, click Comments.  

• To let only authorized reviewers insert comments and changes, type a password. 

Check for macros that might contain viruses whenever you open a 
document 
For more information, see Turning on or off macro virus protection on page 19. 

Security features in Excel 
Microsoft Excel provides the following security and protection features: 

• Add, change, or remove password protection.  

• Limit access to workbook and worksheet elements.  

• Protect the change history for a shared workbook.  

• Check for macros that might contain viruses whenever you open a workbook.  

• Remove personal or hidden information from a workbook. 

Administrators will want to encourage the use of these security and protection features with Excel 
users who are handling sensitive company data in Excel workbooks. 
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Add, change, or remove password protection  
Passwords are case sensitive. Type the password exactly as you want users to enter it, including 
uppercase and lowercase letters. When you create a password, write it down and keep it in a secure 
place. If the password is lost, you will not be able to open or gain access to the data in a password-
protected workbook. 

To add, change, or remove password protection 

1. On the File menu, click Save As.  

2. Click Options, and then do one of the following: 

To Do this 

Require users to enter a password in 
order to open a workbook 

1. In the Password to open box, type a password, and then 
click OK.  

2. In the Reenter password to proceed box, type the 
password again, and then click OK.  

Require users to enter a password in 
order to modify a workbook 

1. In the Password to modify box, type a password, and then 
click OK.  

2. In the Reenter password to modify box, type the password 
again, and then click OK.  

Change a workbook password 1. In the Password to open or Password to modify box, 
select the symbols that represent the existing password. 

2. Type the new password, and then click OK.  

3. In the Password to open or Reenter password to modify 
box, type the password again, and then click OK.  

Delete a workbook password 1. In the Password to open or Password to modify box, 
select the symbols that represent the existing password.  

2. Press DELETE, and then click OK.  

 

3. Click Save.  

4. If prompted, click Replace to replace the existing workbook with the open workbook. 

Note   In a workbook that has been password protected from modifications only, you can save 
changes without using the password by first opening the workbook as read-only. Make the changes 
you want in the workbook, and then save it with a different name. The workbook saved with a new 
name does not require a password and is available for editing.  
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Limit access to workbook and worksheet elements  
To limit access to workbook and worksheet elements, do one of the following: 

To Do this 

Prevent users from making changes to cells on 
worksheets or to data and other items in charts, 
and from viewing hidden rows, columns, and 
formulas 

1. Before you protect the worksheet, hide any 
formulas that you don't want to be visible and 
unlock any cells that you want to be accessible 
for changes while the worksheet is protected.  

2. On the Tools menu, point to Protection, and 
then click Protect Sheet.  

3. Under Protect worksheet for, select the 
Contents check box.  

Prevent users from making changes to graphic 
objects on worksheets or in charts 

1. Unlock any graphic objects that you want to be 
able to change after you protect the worksheet.  

2. On the Tools menu, point to Protection, and 
then click Protect Sheet.  

3. Under Protect worksheet for, select the Objects 
check box.  

Prevent users from making changes to the 
definitions of scenarios on a worksheet 

1. On the Tools menu, point to Protection, and 
then click Protect Sheet.  

2. Under Protect worksheet for, select the 
Scenarios check box.  

Protect the structure of a workbook so that 
worksheets in the workbook can't be moved, 
deleted, hidden, unhidden, or renamed, and 
new worksheets can't be inserted 

1. On the Tools menu, point to Protection, and 
then click Protect Workbook.  

2. Under Protect workbook for, select the 
Structure check box.  

Use windows of the same size and position each 
time the workbook is opened 

1. On the Tools menu, point to Protection, and 
then click Protect Workbook.  

2. Under Protect workbook for, select the 
Windows check box.  
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To prevent other users from removing workbook protection 

• In the Password (optional) box, type a password, click OK, and then retype the password.  

Passwords are case sensitive. Type the password exactly as you want it, including uppercase 
and lowercase letters. When you assign a password, write it down and keep it in a secure 
place. If you lose the password, you cannot gain access to the protected workbook or 
worksheet elements. 

Protect the change history for a shared workbook  
This procedure sets a password to prevent unauthorized users from returning a shared workbook to 
exclusive use and from modifying the number of days that change history is recorded. 

To password protect a shared workbook 

1. If your workbook is already shared, stop sharing the workbook.  

2. On the Tools menu, click Share Workbook, and then click the Editing tab.  

3. Select the Allow changes by more than one user at the same time check box.  

4. Click the Advanced tab.  

5. Under Track changes, select Keep change history for, and then in the days box, type the 
number of days you want to maintain the change history.  

6. Click the Editing tab, and then clear the Allow changes by more than one user at the same 
time check box.  

7. Click OK.  

8. On the Tools menu, point to Protection, and then click Protect and Share Workbook.  

9. Select the Sharing with track changes check box.  

10. Type the password in the Password box, and then reenter the password when prompted.  

11. When prompted, save the workbook. 

Remove personal or hidden information from a workbook 
If your users will be sharing copies of a workbook, it is a good idea to have them review personal and 
hidden information and decide whether it is appropriate to include. Here are some ways users can 
make sure that privacy is protected. 

Use password protection   If you save a workbook in a file format that can be read by a great number 
of programs besides Microsoft Excel — for example, .txt, .htm, and .xml formats — any personal 
information described in this topic is easily viewed by anyone who has permission to open the file. By 
saving a workbook in an Excel file format (.xls), even those individuals with permission to open the file 
cannot necessarily find personal information easily. For example, if changes to content are password-
protected, only users who know the password can see who has been granted permission to edit 
certain parts of the workbook. 
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Remove personal information from file properties   You can delete the following personal 
information from the properties for your file: Author, Manager, Company, and Last Saved By. However, 
some Excel features use this information, so if you remove it, these features will not work correctly. 
Removing personal information affects the following features: 

• Send to Mail Recipient (for Review)  

• Tracked changes  

• Comments (names are removed)  

• Metadata-based search engines, such as FindFast, and Microsoft SharePoint Portal Server 
search engines (documents can be indexed by limited data only, such as content and title)  

Check for other hidden information   If you entered personal information, such as your name or e-
mail address, when you registered your software, some Microsoft Office documents store that 
information as part of the workbook. Information contained in custom fields that you add to the 
document, such as an "author" or "owner" field, is not automatically removed. You must edit or remove 
the custom field to remove that information. 

Unless you send your document to Microsoft, Microsoft does not have access to any information from 
your document. 

Security features in PowerPoint 
To prevent the possibility that macros containing viruses might contaminate a user’s system, follow 
this procedure to display a warning message whenever the user tries to open a presentation that 
contains a macro. This message appears regardless of whether the macro actually contains a virus. 
Users should review the source of a presentation before opening it. 

1. On the PowerPoint menu, click Preferences, and then click the General tab.  

2. Select or clear the Enable macro virus protection check box.  

If macro virus protection is turned off, users run the risk of infecting their computers with a virus, 
which could result in serious damage to their data. 
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Macro issues 
The following issues may arise in relation to the PowerPoint macro security features: 

• Users cannot use a macro in a presentation or add-in program open in PowerPoint 
2004. 

The user might have chosen to disable macros when opening the presentation. To run the 
macros, close and then reopen the presentation or unload and reload the add-in program, 
and then click Enable Macros. 

• Users cannot view the macros in a presentation or add-in program opened in PowerPoint 
2004. 

The macros might have been digitally signed from within the Visual Basic Editor in PowerPoint 
for Windows. PowerPoint 2004 does not recognize digital signatures, so it cannot update the 
signature if you modify a signed Visual Basic for Applications macro. Users cannot view in 
PowerPoint 2004 the code for macros that have been digitally signed in PowerPoint for 
Windows. 

• Users keep getting a warning about macros. 

Users might be receiving the macro warning for any of the following reasons: 

• The macro might contain a virus   If you don’t expect the presentation to contain a 
macro, the macro could be trying to infect the presentation with a virus. Check the 
computer for viruses, and then try to get an uninfected copy of the presentation from the 
source. 

• The macro might be in a file that you downloaded as an HTML page from a Web site 
and opened as a temporary file   If your virus scanner tells you that it has removed a 
virus in this file every time you open it, you are removing the virus from the temporary file 
only and not from the original file on the Web server. Check the computer for viruses, and 
then notify the source about problems with the original file.  

• The presentation contains legitimate macros   PowerPoint cannot distinguish between 
safe and unsafe macros. You can disable macro virus protection in PowerPoint if you no 
longer want to see these messages.  
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Messenger for Mac security 
Messenger offers two types of communication services — a personal account and a corporate account. 
If you have set up a personal account with the MSN Messenger service on the Microsoft Passport 
Network, there are no security features in Messenger for an administrator to control. However, there 
are port and proxy settings that must remain open for Messenger to operate. A network attack that 
disables these settings is a possible threat. 

If you have a corporate account, your organization uses Microsoft Live Communications Server 2005 
or later, which allows you to chat with other people in your company without leaving the company 
firewall. Security features of Live Communications Server include end-to-end encryption through the 
Transport Layer Security (TLS) protocol and full authentication through Active Directory. The 
administrator for your organization controls these security features. For information about planning 
and deploying Messenger in an organization that runs Live Communications Server, see the Microsoft 
Messenger for Mac 5.0 Network Deployment Guide on the Resources page at 
http://www.microsoft.com/mac/. 

Messenger ports 
If you have set up a personal account, the following ports are used for Messenger: 

• TCP port 1863 for Chat functionality 

• TCP ports 6891 to 6900 for File Transfer functionality 

With File Transfer, a new port is opened for each transfer concurrently. If a user sends five files at one 
time, the ports used would be ports 6891, 6892, 6893, 6894, and 6895, respectively. After one 
transfer is finished, the port returns to the queue to be used for any additional transfers. If you do not 
want all of the ports open, you can open one or two ports and instruct your network users to restrict 
file transfers to one at a time. 

For a corporate account, the Microsoft Live Communications Server is on a LAN, so you do not need to 
open any ports to an external network. If the TCP protocol is used, after the Messenger for Mac client 
connects to a Live Communications Server, the server will connect back to the client on a random 
port, or a random port in a specific range that you specify. If the machine firewall is turned on, you 
must add these ports to the Allow list in the firewall settings. For more information, see the Microsoft 
Messenger for Mac 5.0 Network Deployment Guide on the Resources page at 
http://www.microsoft.com/mac/. 

If the TLS protocol is used, the server does not connect back to the client and there is no need to 
change the firewall settings. 

http://go.microsoft.com/fwlink/?LinkId=52361&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=52361&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=52361&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=52361&clcid=0x409
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Proxy settings 
The proxy settings for Messenger have not changed from previous versions of Messenger. Messenger 
still uses SOCKS 4 (or SOCKS 5 with authentication) and HTTP. When Messenger is started, proxy 
information is pulled from System Preferences in the following order: SOCKS 4, and then HTTP. 

If Messenger is unable to detect the proxy settings, these settings can be edited from within System 
Preferences when the user is not signed in. 

Virtual PC security 
Microsoft Virtual PC uses the security features of both Mac OS X and Microsoft Windows. To learn 
more about the security features of Mac OS X, see Mac Help. 

Windows running on a virtual machine is less susceptible to viruses than Windows running on a 
Windows-based computer. It is unlikely that a virus will affect the Mac OS or Mac files; however, in 
certain circumstances, your virtual machine running Windows exposes you to the same security risks 
faced by users running Windows on a Windows-based computer. To lower your risk, make sure you 
always install the latest Windows security patches and service releases. 

Check for Windows updates on the Internet 
To protect the Microsoft Windows operating system that is running on your virtual machine, check for 
updates on the Windows Update Web site. The Windows Update Web site provides a tool that scans 
your virtual machine and gives you a selection of updates that apply to the specific software on your 
virtual machine. New content is added to the Windows Update Web site regularly, so you can always 
get the most recent updates and solutions. 

1. In Windows, on the Start menu, click Help and Support.  

2. Under Pick a Task, click Keep your computer up-to-date with Windows Update.  

3. The first time you go to the Windows Update Web site, click Yes when prompted to install any 
required software or controls. 

4. On the Windows Update home page, click Scan for updates. 
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Mac OS X security 
Mac OS X uses open-source, standards-based security technologies that are easy to administer. 
Administrators who experience any security problem that they suspect is related to the use of Mac OS 
on their network can contact Apple at the Apple security Web site, 
http://www.info.apple.com/usen/security. 

By default, Mac OS X closes all communication ports and services, such as file sharing, Web sharing, 
remote login, FTP access, remote Apple events, and printer sharing. Also by default, the root account 
is disabled. However, authorized users can turn on these services, because the root account has full 
access to the system.  

Various security technologies supported in Mac OS X will be of interest to administrators who want to 
determine the overall security of their network clients. For a list of these standards, search for 
“Security technologies” in Mac Help.

http://www.info.apple.com/usen/security
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This chapter discusses the features and connection options that provide Microsoft Entourage 2004 for 
Macintosh clients with access to an Exchange Server environment. This chapter also describes other 
options from Microsoft for connecting to Exchange. 

This chapter covers the following topics: 

• Deployment options for Exchange Server and Microsoft Office for Mac 

• What's new in Entourage 2004 

• Exchange Server configuration and synchronization 

• Getting users started in Entourage 2004 

• Using the new Entourage 2004 functionality 

• Troubleshooting Entourage Exchange mail accounts  
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Deployment options for Exchange Server and Office for Mac 
The deployment option your organization chooses for integrating Microsoft Office for Mac with an 
Exchange environment depends on three factors: 

• The version of Office for Mac your organization uses 

• The version of the Mac OS your organization uses 

• The functionality requirements of your users 

This section covers the Exchange integration capabilities of different versions of Office for Mac and the 
Mac OS and helps administrators choose which version to deploy according to the needs of their 
users. 

Macintosh client options that are available for Exchange Server 
Macintosh customers now have the following options for operating within Microsoft Exchange Server 
environments:  

• Microsoft Entourage 2004 for Mac 

• Microsoft Outlook 2001 for Mac  

• Microsoft Entourage X for Mac or Microsoft Entourage 2001 for Mac 

• Microsoft Office Outlook Web Access  

• Remote Desktop Connection Client for Mac 

• Microsoft Virtual PC for Mac 
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These options are not mutually exclusive. You can use any combination of the preceding options in 
your organization. The following chart compares the features in each option. 

Comparing options for Macintosh client computers in Exchange Server environments 

Criteria of 
comparison 

Entourage 
2004 

Outlook 
2001 

Entourage X 
or 
Entourage 
2001 

Outlook 
Web 
Access 

Remote 
Desktop 
Connection 
Client for 
Mac 

Virtual 
PC for 
Mac 

Client operating 
system 
supported 

Mac OS X 
10.2.8 or 
later 

Mac OS 
8.6 – 9.x 
or 
Mac OS X 
(10.2.x 
and 
earlier) 
Classic*  

Mac OS 8.6 – 
9.x or 
Mac OS X 
(Classic 
required) 

All Mac 
OS 
versions 

Mac OS X 10.1 
or later 

Mac OS X 
10.2.8 or 
later 

Client software 
required 

Entourage 
2004 

Outlook 
2001 

Entourage  X 
or Entourage 
2001 

Internet 
Explorer 
5.x 

Remote 
Desktop 
Connection 
(and Outlook 
for Windows 
on the 
computer 
running 
Remote 
Desktop 
Connection) 

Virtual PC 
for Mac, 
Microsoft 
Windows, 
Outlook 
for 
Windows 

Additional 
server-side 
requirements 

Microsoft 
Exchange 
2000 Server 
or later (with 
Service Pack 
2 or later).  

Must enable 
the following 
protocols: 
HTTP DAV 
(Outlook 
Web Access) 
and LDAP.  

None Must enable 
Internet 
Messaging 
Protocol 
(IMAP) 

Must 
enable 
Outlook 
Web 
Access  

Operating 
system 
software 
support for 
Remote 
Desktop 
Protocol 

None 
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Criteria of 
comparison 

Entourage 
2004 

Outlook 
2001 

Entourage X 
or 
Entourage 
2001 

Outlook 
Web 
Access 

Remote 
Desktop 
Connection 
Client for 
Mac 

Virtual 
PC for 
Mac 

Support for 
offline access to 
data and 
reminders 

Yes Yes Yes No No Yes 

100% same 
experience as 
using Outlook 
on a Windows-
based computer 

Similar Similar No No Yes Yes 

Support for 
handheld 
synchronization 

Yes No Yes No No Yes 

Support for 
scheduling and 
delegated group 
calendaring 

Yes Yes No Yes Yes Yes 

Support for 
Exchange-based 
e-mail 

Yes Yes Yes Yes Yes Yes 

Support for 
HTML mail 

Yes No Yes Yes Yes Yes 

Support for 
other e-mail 
protocols such 
as POP, IMAP, 
and Hotmail 

Yes No Yes No Yes Yes 

Support for .PST 
files 

Yes Yes No No Yes Yes 

Support for 
delegation 

Yes Yes No Yes Yes Yes 
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Criteria of 
comparison 

Entourage 
2004 

Outlook 
2001 

Entourage X 
or 
Entourage 
2001 

Outlook 
Web 
Access 

Remote 
Desktop 
Connection 
Client for 
Mac 

Virtual 
PC for 
Mac 

Support for 
Global Address 
List directory 
search 

Yes Yes No Yes Yes Yes 

More Mac-like Yes No Yes No No No 

Requires 
knowledge of 
Windows 

No No No No Yes Yes 

Can be used 
with the other 
solutions 
simultaneously 

Yes Yes Yes Yes Yes Yes 

 

Notes 

• Classic refers to software included with Mac OS X that you can use to run Mac OS 9 
(or earlier) applications. 

• The Remote Desktop Connection features are compared using Windows Outlook 2000 
or later. 
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Choosing a solution 
The following decision trees can help you determine which solution is right for you, depending on the 
Mac OS version you prefer to use. Remember, you can use more than one solution at the same time 
in your organization. 

                Mac OS X Only 

Need to access an Exchange Server? 

Would clients consider running 
Windows on their Macintosh computers? 

Need to do more than e-mail, scheduling, 
shared calendaring, delegation, and 
directory access? 

Do clients have access to Remote Desktop 
Connection (for example, Outlook installed 
on a Windows 2003, 2000, or NT 4 Server 
with Terminal Services enabled, or a 
Windows-based computer with Outlook 
and Windows XP Professional with Remote 
Desktop Connection)? 

Use Microsoft  
Entourage 2004

Yes

No

Yes

No

No

Yes

No

Yes

Use Microsoft  
Entourage 2004

Use Virtual PC  
with Outlook

Use Remote Desktop 
Connection

Use Outlook Web 
Access
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                Mac OS 8.6-9.x Only 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Setting up Entourage 2004 for Mac 
Entourage 2004 offers the best option for Exchange users who are using a Macintosh computer with 
OS X. This Exchange e-mail client provides customers with comprehensive Exchange functionality, 
including robust e-mail, group calendaring, and basic support for public folders containing mail items 
and delegation in a corporate Macintosh environment. 

Client-side requirements for Entourage 2004  

• Mac OS X 10.2.8 or later.  

• Entourage 2004 for Mac (available as part of Microsoft Office 2004 for Mac).  

Server-side requirements for Entourage 2004 

• Microsoft Exchange 2000 Server or later (with Service Pack 2 or later). This is required for 
WebDAV support. 

• Outlook Web Access must be installed and active.  

• The following protocols must be enabled: WebDAV (used by Outlook Web Access and 
Entourage 2004) and Lightweight Directory Access Protocol (LDAP).  

Need to access an Exchange Server? 

Do clients need to have offline access to 
data, reminders, delegation, voting, and a 
full range of Exchange server information? 

Need to access more than basic Exchange 
e-mail functions, such as scheduling, 
shared calendaring, delegation, or voting? 

Use Microsoft  
Entourage 2001

Yes 

No

No

No 

Yes

Use Microsoft  
Entourage 2001

Use Microsoft Outlook 
2001 for Mac

Use Outlook Web 
Access

Yes
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Setup and use of the client  

If Entourage 2004 is the best choice for the client, and the preceding requirements are met, then you 
must configure an Exchange account in Entourage.  

Ensure that the computer is connected to a network that has access to the Exchange server.  

To set up an Exchange account with default settings, use the Account Setup Assistant. The Assistant 
uses the account ID, password, and domain that you provide to automatically detect the correct 
settings for an account. The Account Setup Assistant uses the Domain Name System (DNS) servers 
configured in the client Network System Preferences to locate the Active Directory global catalog 
server that is authoritative for the domain. It then sends an LDAP query using the account ID and 
password to authenticate the user. In addition to receiving Exchange mail, all contacts and Calendar 
items are synchronized with the Exchange server.  

To set up the client account 

1. In Entourage, on the Tools menu, click Accounts.  

2. Click the Exchange tab, and then click New. (If you see the New Account dialog box, click the 
Assist Me button.)  

3. Do one of the following: 

• Follow the instructions in the Account Setup Assistant.  

• To set up your account without the Assistant, click Configure account manually.  

Notes 

• If you want to specify synchronization settings while you are setting up your account, you can 
configure the account manually. You can also configure the account manually after the 
Assistant has attempted automatic configuration. 

Limitation  

A possible drawback to this solution is that certain advanced Exchange features, such as voting, 
shared tasks, shared notes, and server-side rules, are not accessible. Entourage 2004 provides a 
solution for e-mail, group calendaring, scheduling, Global Address Book, public folders, Address Book, 
Calendar, and Mail folder sharing and delegation.  

For more information, see Differences between Entourage 2004 and Outlook for Mac on page 73. 

Additional resources 

For more information about Entourage, go to Entourage 2004 for Mac on the Microsoft Web site at 
http://www.microsoft.com/mac/. 

http://go.microsoft.com/fwlink/?LinkId=31941&clcid=0x409
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Setting up Outlook 2001 for Mac 

Client-side requirements for Outlook 2001 

• Mac OS 8.6 to 9.x or OS X (10.2.x and earlier) Classic  

• Microsoft Outlook 2001 for Mac  

Setup and use of the client 

If Microsoft Outlook 2001 is the best choice for the client, and client-side requirements (listed earlier 
in this chapter) are met, then you are ready to set up Outlook 2001. 

To set up Outlook 2001 to work with Exchange server 

1. Start Outlook 2001.  

2. In the Microsoft Exchange Server box, type the name of your Exchange server.  

3. In the Mailbox Name box, type your user name.  

4. To access your Exchange account while your computer is not connected to a network, select 
No for Is this computer always connected to a network? (Portable computer users and 
dial-up users will probably want to select No.)  

5. Click Test Settings.  

6. Follow the instructions in the Setup Assistant, and then log on to begin using Outlook.  

Limitations 

Possible drawbacks to this solution might include the following: 

• Some users prefer not to run Classic applications in OS X.  

• Certain features, such as portable digital assistant (PDA) synchronization and HTML e-mail 
editing, are not available.  

• Outlook 2001 cannot access any e-mail accounts other than Exchange accounts. (For 
example, it cannot access IMAP, POP, and Hotmail accounts.)  

Additional resources 

For more information, see Outlook 2001 for Mac on the Microsoft Web site at 
http://www.microsoft.com/mac/. 

http://go.microsoft.com/fwlink/?LinkId=31942&clcid=0x409
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Setting up Entourage X or Entourage 2001 for Mac 

Client-side requirements for Entourage 2001 

• Mac OS 8.5 to 9.x  

• Microsoft Entourage 2001 for Mac  

Client-side requirements for Entourage X 

• Mac OS 10.1 or later  

• Microsoft Entourage X for Mac  

Server-side requirements for Entourage 2001 

• Microsoft Exchange Server 5.5 Series or later must be installed. 

• IMAP must be enabled on the server. It is on by default only in Exchange 2000 Server.  

Server-side requirements for Entourage X 

• Microsoft Exchange 2000 Server or later with Service Pack 2 or later must be installed. 
Entourage X and Microsoft Exchange Update for Entourage X [Microsoft Office v. X (10.1.4) 
for Mac] can connect to an Exchange 5.5 server using an IMAP account. Exchange Update for 
Entourage X requires Exchange 2000 to synchronize contacts and events, but it can receive 
mail from an Exchange 5.5 server. 

• IMAP must be enabled on the server. It is on by default only in Exchange 2000 Server.  

Setup and use of the client 

If Microsoft Entourage is the client, and the preceding requirements are met, then you must configure 
an e-mail account in Entourage. 

1. Start Microsoft Entourage.  

2. On the Tools menu, click Accounts.  

3. Click the Mail tab, and then click New.  

4. If you receive a message from the Account Setup Assistant, click Configure account 
manually. If not, then proceed to the next step.  

5. In the Account Name box, type the name for this account, such as Exchange account.  

6. In the Name box, type the user's name.  
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7. In the E-mail Address box, type the user's complete e-mail address, such as 
someone@microsoft.com.  

8. In the Account ID box, type the user's domain and user name in the following format: 
domain\username.  

9. In the IMAP Server box, type the Exchange server address for this user.  

10. In the Password box, type the password for the user's Exchange account.  

11. In the SMTP Server box, type the Exchange server address.  

12. Click Click here for advanced sending options.  

13. Select the SMTP server requires authentication check box.  

14. Click OK to save these changes.  

15. To begin sending and receiving messages, click Send & Receive.  

Limitations 

Possible drawbacks to this solution might include the following: 

• Entourage 2001 and Entourage X are currently a solution for basic e-mail only (although 
Exchange Update for Entourage X does provide basic Exchange support). Advanced Exchange 
features, such as group calendaring, scheduling, voting, delegation, public folders, shared 
tasks, and shared notes, are not accessible.  

Additional resources 

You can find tips on configuring Entourage for Exchange in this document or in the Read Me file that 
accompanies Entourage. 

Using Outlook Web Access 

Client-side requirements for Entourage 2001 

• Mac OS 8.1 to 9.x or Mac OS X  

• Internet Explorer for Mac 5.1.6 or 5.2.2  

Server-side requirements for Entourage 2001 

• Microsoft Exchange Server 2003, Exchange 2000 Server or later (with Service Pack 2 or later) 
or Microsoft Exchange Server 5.5 Series must be installed. 

• Outlook Web Access must be installed and active.  
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Setup and use of the client 

If Outlook Web Access is the client, and the preceding requirements are met, then no additional setup 
is necessary for this solution. 

1. To access the Exchange server by using Outlook Web Access, first start Internet Explorer.  

2. Type the address for the Outlook Web Access Web site into the address bar. The Exchange 
server administrator can provide the address. It usually follows the form: 

http://name_of_exchange_server/exchange 

- or - 

https://name_of_exchange_server/exchange  

3. After entering the user name, password, and domain name, you can use the Outlook Web 
Access site as you would Microsoft Outlook.  

Limitations 

Possible drawbacks to this solution might include the following: 

• Outlook Web Access does not provide offline access to data.  

• Notes and tasks might not be displayed correctly.  

Additional resources 

For more information, see Outlook Web Access for Exchange 2003 on the Microsoft Web site at 
http://www.microsoft.com/exchange/. 

Setting up Microsoft Remote Desktop Connection Client for Mac 

Client-side requirements for Remote Desktop Connection 

• Mac OS X 10.1 or later  

• Remote Desktop Connection Client for Mac  

Server-side requirements for Remote Desktop Connection 

• The Windows Server 2003 operating systems, Windows 2000 Server operating systems, 
Windows NT Server 4.0 Terminal Server Edition, or Windows XP Professional must be 
included. 

• Remote Desktop Connection or Terminal Services must be configured and active.  

• Outlook 2000 or Outlook 2002 must be installed and configured on the remote computer.  

http://go.microsoft.com/fwlink/?LinkId=31943&clcid=0x409
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Setup and use of the client 

If Remote Desktop Connection Client for Mac is the best choice for the client, and the preceding 
requirements are met, then very little setup is required to begin using Remote Desktop Connection. 

1. Start Remote Desktop Connection Client for Mac.  

2. In the Computer box, type the name of the Windows server or personal computer to use 
remotely.  

3. Click Connect.  

4. To log in, type your user name, password, and domain name.  

5. On the remote computer, start Outlook.  

When you start Remote Desktop Connection, a Windows session is established on a remote computer. 
This is a viable solution for companies with Macintosh users who need to collaborate with Windows 
users who are using non-Mac applications. 

Limitations 

Possible drawbacks to this solution might include the following: 

• Remote Desktop Connection requires a Windows-based computer and is not designed for 
Mac-only organizations.  

• Users must be familiar with Windows and Outlook for Windows.  

• No offline support is available.  

• The cost of servers might be prohibitive, and users might lack server maintenance skills.  

Additional resources 

For more information, see Remote Desktop Client on the Microsoft Web site at 
http://www.microsoft.com/mac/. 

Setting up Virtual PC for Mac 

Client-side requirements for Virtual PC 

• Macintosh clients must be running Virtual PC for Mac Version 7 or Virtual PC for Mac  
Version 6. 

• The Macintosh client must have enough virtual memory to run the number of virtual machines 
desired.  

http://go.microsoft.com/fwlink/?LinkId=31944&clcid=0x409
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If you select a value less than 32 MB for the virtual RAM setting, which is the lowest recommended 
amount for most x86-based computers, Virtual PC for Mac displays a warning. This warning is 
displayed regardless of the operating system that is installed on the virtual machine, and might not 
be relevant for the virtual machine for which you are specifying the setting. You should determine for 
yourself the minimum amount of memory required by the operating system installed on the virtual 
machine. You can find this information in the manual for the particular operating system. 

Server-side requirements for Virtual PC 

• Windows Server 2003 operating systems, Windows 2000 Server operating systems, Windows 
NT Server 4.0 Terminal Server Edition, or Windows XP Professional must be installed and 
configured on the virtual machine. 

• Outlook 2000 or Outlook 2002 must be installed and configured on the virtual machine.  

Client setup 

To install the version of Windows included with Virtual PC 7, use the Create New PC Assistant wizard 
to install the virtual machine and the Microsoft Windows operating system. Do not use this method to 
install any other operating system. 

1. In Virtual PC for Mac, on the File menu, click New.  

2. On the Select a Setup Method screen, click Install from a Virtual PC for Mac CD, and then 
click Begin.  

3. Insert the CD for Virtual PC 7 in the CD drive of your Macintosh, and then click Continue.  

4. In the Name box, type a name for your virtual machine, such as Windows XP Professional.  

You can either accept the name that is provided, or you can create your own name. If you do 
not create a name, Virtual PC for Mac uses the name of the operating system that you are 
installing—for example, Windows XP Professional. 

5. To install the configuration information and operating system files for your virtual machine, 
do one of the following:  

• To accept the default location, click Install.  

• By default, the Assistant installs the configuration information and operating system files 
for your virtual machine in the User/Documents/Virtual PC List folder on your Macintosh 
hard disk. 

• To select a different location, click Change Location, select a location, and then click 
Install. 

6. On the Getting Started screen, click Start Windows.  
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Limitations 

• The Virtual PC for Mac solution uses a Windows-based operating system and is not designed 
for Macintosh-only organizations.  

• Users must be familiar with Windows and Outlook for Windows.  

• The use of RAM for each virtual machine might be prohibitive, and performance for each 
virtual machine can be slower than running the operating system on a stand-alone machine.  

Additional resources 

For more information, see Virtual PC for Mac on the Microsoft Web site at 
http://www.microsoft.com/mac/. 

What’s new in Entourage 2004 
Several new features and improvements in Microsoft Entourage 2004 are important to network and 
system administrators who support Exchange clients.  

Support for World Wide Web Distributed Authoring and Versioning 
Entourage 2004 uses the World Wide Web Distributed Authoring and Versioning (WebDAV) standard 
as the connection protocol for Exchange mail accounts. Microsoft Exchange Server began supporting 
WebDAV in Exchange 2000 Server with the integration of Outlook Web Access and the IIS Web service. 
Exchange Server 2003 supports WebDAV. 

Entourage 2004 is designed to meet the most important customer feature requirements. It does this 
by using secure, established protocols. Entourage 2004 has been improved with support for e-mail 
over the WebDAV protocol, which provides additional functionality and better performance in a 
low-bandwidth environment, as well as basic support for delegate access to Exchange calendars, 
contacts, and e-mail. Additionally, Entourage 2004 uses WebDAV for calendar and contact 
synchronization. For Global Address List directory lookups, Entourage 2004 uses LDAP. Exchange 
Server 2003 uses VLV (virtual list view). 

WebDAV provides the following benefits to users and Exchange administrators: 

• Eliminates the need for IMAP and SMTP access to Exchange Server for Entourage clients.  

• Provides basic support to allow for delegate access and mail public folders.  

• Allows users to access mail on a server behind the firewall without tunneling by using 
forms-based authentication. 

If an Exchange Server administrator has configured Exchange Server to support Outlook Web Access, 
then, by default, this configuration also supports Entourage 2004 Exchange mail accounts, and no 
further Exchange administration is required.  

For more information about administering Exchange Server to support the WebDAV access by 
Entourage 2004 clients, see the Exchange Server 2003 Technical Documentation Library at 
http://www.microsoft.com/technet/. 

http://go.microsoft.com/fwlink/?LinkId=31945&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=31946&clcid=0x409
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Account setup improvements 
The Entourage Account Setup Assistant has been improved in the following ways.  

• Improvements have been made to the Assistant, reducing the amount of information users 
are required to enter from previous versions of Entourage.  

• Entourage 2004 supports scenarios where the user ID (Active Directory user account) 
specified by the user does not match the e-mail address specified by the user. 

• Entourage 2004 supports virtual server scenarios where the path to the user’s data is not 
http://<server>/exchange/<user>. Users can enter the full path to their data in the Exchange 
server field of the account dialog box (for example, 
http://<server>/<value>/<different_name>). 

• Entourage 2004 correctly retains changes to user names and passwords. If a user changes 
his or her user name and password in the domain, Entourage 2004 removes the Exchange 
server and user name mapping data. The mapping data is removed to ensure that local 
Entourage data is not deleted when the user next synchronizes with an Exchange server. 
Otherwise, it would appear that all contacts had been deleted on the Exchange server, and 
the synchronization process would remove these from the local Entourage data. Instead, the 
Exchange Server data will be downloaded again, which can take longer than a typical 
synchronization. 

• Entourage 2004 turns off synchronization in additional Exchange accounts. If a user creates 
multiple Exchange accounts, it is likely that the user does not want to synchronize every item 
from all accounts because this would in effect merge them. Therefore, when a user creates 
another Exchange account (automatically or manually), Entourage 2004 turns off 
synchronization by default.  

Forms-based authentication 
User accounts are authenticated with the Exchange Server before Entourage 2004 synchronizes the 
data. This authentication is performed using the forms-based authentication feature of Exchange 
Server. Other transactions between Entourage and the Exchange Server, including synchronization, 
are authenticated by passing a cookie from Entourage to the Exchange Server. The support for 
WebDAV in Entourage 2004 enables forms-based authentication. 

Once both Exchange server and Entourage 2004 are configured for forms-based authentication, 
Exchange users can log into their Exchange accounts by using Entourage 2004. For more information 
about configuring forms-based authentication in Exchange server and Entourage 2004, see 
Forms-based authentication on page 64. 
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Delegate access 
Entourage users can be granted permission to open another person's folders, create items, and 
respond to requests for that person. Before an Entourage user can access and manage another 
person's Exchange information, the person granting delegate permission determines the folders the 
delegate can access and the changes the delegate can make. Delegate access can be set up and 
managed by using Entourage 2004 . For more information, see Using delegation on page 65. 

Public Folders 
Users can subscribe to and create their own Exchange server public folders. 

Sharing 
Users can share Exchange Address Book, Calendar, and Mail folders.  

Multiple Address Books, Calendars, and Mail folders 
Users can create multiple Address Books, Calendars, and Mail folders on the Exchange server by using 
Entourage. 

Configuring and synchronizing with the Exchange Server  
This section describes the Exchange Server configurations necessary for supporting the Entourage 
2004 Exchange client. This section also describes the synchronization between Entourage 2004 and 
Exchange Server. 

Server requirements 
Entourage 2004 requires Exchange 2000 Server Service Pack 2 or later, just as Exchange Update for 
Entourage X does.  

Directing an Entourage 2004 Exchange mail account to an earlier version of Exchange Server, such 
as Exchange Server 5.5, does not work because earlier versions of Exchange Server do not support 
WebDAV. Exchange Server 5.5 users can use Outlook, Remote Desktop Connection Client for Mac, 
or Virtual PC for Mac for full Exchange functionality, and might be able to use an IMAP account in 
Entourage to get mail from the server if the server has IMAP enabled. 

Client-side requirements for Microsoft Entourage 2004  

• Mac OS X 10.2.8 or later.  

• Microsoft Entourage 2004 for Mac (available as part of Microsoft Office 2004 for Mac).  

Server-side requirements for Microsoft Entourage 2004 

• Microsoft Exchange 2000 Server (with Service Pack 2) or later. 

• Outlook Web Access must be installed and active.  

• The following protocols must be enabled: WebDAV (used by Outlook Web Access and 
Entourage 2004) and LDAP.  
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Entourage functionality notes 
The following notes describe common issues with administering Entourage clients. 

• Entourage cannot manage automatic distribution lists. Automatic Distribution List 
Management (AutoDL) can be used to manage distribution list memberships; Microsoft 
Outlook is not required. AutoDL provides a Web-browser interface to group management 
within the Microsoft Active Directory service. Users can add or delete new mailing and security 
groups and centrally manage the membership list of owned groups. Additionally, non-group 
owners can request to be added and removed from existing group lists. For more information, 
see AutoDL Version 2.1 on the Microsoft Web site at http://www.microsoft.com/exchange/. 

• If the TCP/IP network address configured in Network Preferences is changed on the 
Macintosh client, you must restart Entourage to reconnect to the Exchange server. 

• When an item is deleted from a folder in a mailbox, that item is first transferred to the Deleted 
Items folder of that mailbox. Users can then remove the item from the Deleted Items folder. 
This provides a measure of protection in case a user accidentally deletes an item. After the 
items are removed from the Deleted Items folder, users can still recover them if Exchange 
Server has been configured to retain deleted items. To enable Deleted Item Recovery on mail 
folders such as the Sent Items folder, the Drafts folder, the Outbox folder, and the Inbox 
folder, see Knowledge Base article 178630, XADM: How to Recover Items That Are Not First 
Transferred to the Deleted Items Folder. Outlook Web Access allows users to recover deleted 
items using a URL of the following format: 
http://<serverName>/exchange/<userID>/<folder path>/?cmd=showDeleted&close=1  

• Compacting an Entourage database might cause duplication of mail messages. To fix this 
duplication, delete and recreate the account in Entourage. Compacting an Entourage 
database can also cause problems with message dates, which might cause confusing 
behavior in Outlook, such as the failure to archive old messages. 

• If a user connects to an Exchange account from Entourage before any other client connects, 
then Exchange folders might be created that use the server’s localization (the translation of 
the names of the special folders like Inbox, Sent Items, Drafts) instead of the localization in 
Entourage. A workaround is to use Outlook Web Access or Outlook to connect to the account 
for the first time.  

• If items are duplicated, the following tools can provide assistance: 

• Outlook: http://www.mapilab.com/outlook/remove_duplicates/ 

• Entourage: Various scripts are available at http://scriptbuilders.net. Select the Entourage 
category and search for duplicate. 

http://go.microsoft.com/fwlink/?LinkId=31947&clcid=0x409
http://www.mapilab.com/outlook/remove_duplicates/
http://scriptbuilders.net/
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What is synchronized with the Exchange Server 
Whenever the Macintosh computer running Entourage 2004 is connected to an Exchange Server, 
e-mail messages, contacts, and Calendar items are synchronized. Other Exchange Server products 
(for example, Microsoft Outlook on a Windows-based computer) are also synchronized with the 
Exchange Server. However, because these programs display and use information differently, your 
information might look different depending on which program you are using to view it. Some of these 
differences are listed below. 

• If there is a conflict between the Entourage 2004 client-side copy of a synchronized item and 
its server-side copy, the Entourage 2004 client-side copy overwrites the server-side copy. 

• Entourage notes are not synchronized with the Exchange server. 

• Entourage tasks are not synchronized with the Exchange server. 

• Although message flags are synchronized with the Exchange server, the task associated with 
a message flagged for follow up is not synchronized. Flags associated with contacts are not 
synchronized with the Exchange server. 

• Category information that users set in Entourage is not synchronized with the Exchange 
server. 

The following circumstances trigger event and contact synchronization: 

• Account setup. 

• Program startup.  

• Every one minute. 

• After a change is made on a computer connected to the Exchange server. Entourage waits 
one minute before starting synchronization. If a user makes another change, the one-minute 
countdown starts over. This schedule prevents Entourage from starting synchronization too 
frequently when a user edits multiple records. 

E-mail messages and rules 

All Exchange mail folders, including subfolders, can be accessed by using Entourage. Messages in the 
Inbox are continually synchronized with the Exchange server automatically. Depending on the network, 
new messages are either displayed automatically as they arrive or are displayed after Entourage 
completes a check for new messages on the server once every minute. The initial Exchange Server 
synchronization with Entourage 2004 takes longer than subsequent synchronizations.  

Although rules stored on Exchange Server will run, Exchange Server-based rules cannot be created or 
changed by using Entourage. To change a server-based rule from the Macintosh computer, users must 
use Microsoft Outlook. 
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Contacts 

In Entourage 2004, a single contact can store up to 13 e-mail addresses. In Outlook on a Windows-
based computer, a contact can store up to three e-mail addresses. When contacts are synchronized, 
Entourage synchronizes the default e-mail address to the E-mail field in Outlook. The next two 
addresses listed in the Entourage contact are synchronized with the E-mail 2 and E-mail 3 fields in 
Outlook. 

A contact created in Outlook can have a mailing address labeled "other." This label is not available in 
Entourage 2004. When contacts are synchronized, Entourage displays an address labeled as "other" 
as the "work" address. If you edit this address in Entourage, then the next time contacts are 
synchronized, the address label in Outlook changes to "business." 

In Entourage, up to 10 children's names can be stored. If an Outlook contact with more than 10 
children listed is edited in Entourage, all but the first 10 names are deleted. 

Calendar 

If users specify travel time in a Calendar item created in Entourage, this information does not appear 
in Outlook. For example, if a user schedules an item for 1:00 PM to 2:00 PM with a travel time of 15 
minutes, the Outlook Calendar blocks out only the one-hour scheduled time and does not include the 
travel time. 

Synchronization settings for contacts and Calendar 

Entourage 2004 users can access contacts stored on an Exchange server from their Macintosh 
computers. Contacts stored on the Exchange server are synchronized with the Entourage Address 
Book and appear just as they do in Microsoft Outlook on Windows-based computers.  

Calendar items stored on an Exchange server can also be accessed from Entourage 2004 and 
synchronized with the Entourage Calendar.  

When an Entourage 2004 user creates a meeting request, the free/busy information for other 
Exchange users in his or her organization is displayed. For example, to invite others to an event, the 
user completes the following procedure: 

To invite others to an event 

1. Create an event. 

2. Click Invite. 

3. Address the invitation. 

4. Click the Scheduling tab to check whether invitees are free or busy. (If you do not see the 
Scheduling tab, make sure your Exchange account is selected in the From box at the top of 
the invitation.)  

5. To send the invitation without requesting responses from attendees, clear the check mark 
next to Request Responses on the Event menu. 
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Notes 

• To view attendee status of an invitation you've sent, open the event, and then click the View 
attendee status link in the Info Bar. 

• Entourage does not detect whether an invitation is out of date or conflicts with other events. 

• Entourage does not support invitation counterproposals in Outlook. 

• To prevent duplicate reminders, try to avoid running Outlook and Entourage at the same time.  

Getting users started in Entourage 2004 
This section describes how to create or import Entourage Exchange mail accounts by using the 
Account Setup Assistant. This section also describes how administrators can enable browser-based 
logon for Entourage users and how free/busy information for users is published. 

How the Account Setup Assistant works 
When a user sets up an Exchange mail account, the Account Setup Assistant attempts to locate the 
information it needs from the Exchange server by doing the following: 

1. It queries the DNS server for all DNS resource records for its domain name to locate the 
Global Catalog (GC) server for the Active Directory domain in which the user account is a 
member. To perform this query, the Assistant uses the DNS server configured in the Network 
Preferences TCP/IP connection of the Mac OS. This query returns all of the resource records 
for Active Directory domain controllers that are hosted by the DNS server. After the GC is 
located, the Assistant performs an LDAP query for the homeMDB LDAP attribute of the user 
account, which lists the Exchange server for the user account.  

2. If the query to the DNS server is unsuccessful, the Assistant attempts to locate the Exchange 
server by using the name of the domain that the user enters for his or her Exchange account. 
For example, if the user enters mydomain.microsoft.com as the domain for an Exchange 
account, the Assistant creates a DNS query for the name mydomain.microsoft.com. The DNS 
resource records returned in response to this query include records for the domain controllers 
in the domain mydomain.microsoft.com. 

3. If the Assistant fails to find the Exchange server information, it provides a simplified user 
interface where the user can enter the information that Entourage could not detect. The 
Account Setup Assistant then offers to verify the settings specified by the user. 
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Importing accounts 
Users with Exchange mail accounts in Exchange Update for Entourage X [Office v. X (10.1.4)] can use 
one of the following two ways to import accounts in Entourage 2004: 

• When first starting Entourage   When Entourage 2004 is started for the first time, the Setup 
Assistant allows the user to import information from Entourage X. If the Entourage X data is 
not imported at setup, it can be imported later.  

• At any time   To import an Entourage X account into Entourage 2004 after setup, on the File 
menu, users can click Import, and then follow the instructions in the Import Assistant. All the 
server-side contact, Calendar, and mail will be downloaded again. 

Forms-based authentication  
Entourage 2004 supports the same cookie-based authentication used by Microsoft Office Outlook 
Web Access clients who connect to their e-mail accounts through a front-end server in a front-end 
back-end server environment. Administrators have the option to enable forms-based authentication 
on the front-end server. 

Administrators must enable Secure Sockets Layer (SSL) on the server before enabling forms-based 
authentication.  

To enable forms-based authentication in Exchange Server 2003 

1. On the Exchange server, log on with the Exchange administrator account, and then start 
Exchange System Manager. 

2. In the console tree, expand Servers. 

3. Expand the server for which you want to enable forms-based authentication, and then expand 
Protocols. 

4. Expand HTTP, right-click Exchange Virtual Server, and then click Properties. 

5. In the Exchange Virtual Server Properties dialog box, click the Settings tab. 

6. In the Outlook Web Access pane, select Enable Forms Based Authentication. 

7. Click Apply, and then click OK. 

Notes 

• With forms-based authentication, users must enter their credentials either in the universal 
naming convention (UNC) format (Domain\Username) or in the user principal name (UPN) 
format (user@domain.com).  

• In Exchange Server 2003, forms-based authentication allows you to set the default domain 
setting in Internet Information Server (IIS) only to the default domain setting of \. This 
restriction is designed to support user logons that use the UPN format. If the default domain 
setting is changed, Exchange System Manager resets the default domain setting to \ on the 
Web server. To work around this issue, consult the Exchange Server documentation. 
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To enable forms-based authentication in Entourage 

1. In Entourage, on the Tools menu, click Accounts. 

2. Select the Exchange account, and then click Edit. 

3. Make sure that Entourage is pointing to your front-end server. On the Account Settings tab, 
in Exchange Server, the name of the front-end server should be listed.  

4. On the Advanced tab, make sure that the DAV service requires secure connection (SSL) 
check box is selected.  

How Entourage 2004 publishes free/busy data 
Entourage 2004 relies on a free/busy publishing agent named MadFB (also known as 
MSExchangeFBPublish), which runs as part of the Microsoft Exchange System Attendant service 
(MSExchangeSA) in Exchange Server. MadFB has two functions: it publishes free/busy messages for 
WebDAV clients, and it deletes duplicate free/busy messages. The MadFB agent is also used in the 
same way by Outlook Web Access and Outlook Mobile Access. 

For more information about how free/busy data is published to Exchange, see Managing Free/Busy 
Folders on the Microsoft Web site at http://www.microsoft.com/downloads/. The document, available 
for download, is a Windows-executable file. 

Using the new Entourage 2004 functionality 
This section discusses how the new Entourage 2004 functionality interacts with Exchange Server, and 
how to use Entourage 2004 to work around some of the default synchronization settings of Exchange 
Server. 

Using delegation 
Before a user can access and manage another person's Exchange information by using Entourage 
2004, the user must be given delegate access from the owner of the account. Delegate access can be 
set up and managed by using Entourage 2004. For more information, see Setting up delegate access 
on page 67. 

http://go.microsoft.com/fwlink/?LinkId=31957&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=31957&clcid=0x409
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If a user already has delegate access to an account owner’s Exchange information, the Microsoft 
Entourage user can read and respond to messages, accept or decline invitations, and change or 
create contact items and Calendar events for the owner. Access can be granted for the following types 
of items: 

• Messages   The Inbox and subfolders (depending on permission level) of the owner appear in 
the Folders list in Entourage Mail view. With the correct privileges, the user can read, respond 
to, and organize messages in the same way as in the user’s own Inbox.  

• Calendar events and Address Book contacts   Items stored in the Calendar and Address 
Book of the owner appear in the user’s Entourage Address Book and Calendar. If a user has 
permission to make changes, any changes the user makes to an item appear the next time 
synchronization occurs in the Address Book or Calendar of the owner. If a delegate creates a 
new contact or Calendar event in the delegated Calendar or Address Book, it is added to the 
Address Book or Calendar of the owner the next time synchronization occurs (according to the 
permissions to make changes to the owner’s Address Book or Calendar).  

• Invitations   When an invitation is accepted, that event is added to the Calendar of the owner 
the next time synchronization occurs.  

Microsoft Entourage delegate access permissions 

The levels of permission that a delegate can be granted are as follows: 

• Reviewer   A delegate can read items. For example, a delegate with Reviewer permission can 
read messages in another person's Inbox. 

• Author   A delegate can read and create items, and modify and delete the items that were 
created. For example, a delegate can create task requests and meeting requests directly in 
the owner's Task or Calendar folder, and then send either item on the owner's behalf. 

• Editor   A delegate can do everything an Author can do, and modify and delete the items the 
owner created. 

Sent by permissions 

A delegate can send e-mail messages on behalf of the person he or she is a delegate for. Sent 
messages contain both the owner's and delegate's names. Message recipients see both the owner's 
name and the delegate's name in the From box. 

If a user grants someone a permission level of editor for his or her Calendar, he or she can also 
delegate permission to accept, decline, or mark as tentative meeting requests on his or her behalf. 
The delegate receives copies of meeting-related messages sent to the account owner. After the 
delegate responds to the meeting on the owner’s behalf, the meeting is automatically added to the 
account owner’s Calendar if the response to the meeting is Accept or Tentative. 

A person with delegate access or permission to read the owner’s items might be able to view the 
owner’s private contacts and events by using other software programs. To protect privacy, the owner 
can place private items in a separate, non-shared Calendar or Address Book.  
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Setting up delegate access 

To set up delegate access in Entourage 2004 

1. On the Tools menu, click Accounts.  

2. On the Exchange tab, click the account that you want to add a delegate to, and then click 
Edit.  

3. On the Delegate tab, under My Delegates, click Add.  

4. Type the name of the user who will be the delegate and click Find.  

5. Click the name of the user and click OK.  

6. Do one or more of the following:  

• To set Calendar permissions, on the Calendar pop-up menu, click the Calendar 
permission level that you want the delegate to have.  

• To have copies of meeting-related messages sent to the delegate, select the 
Delegate receives copies of meeting-related messages sent to me check box. The 
delegate must have the permission level of editor.  

• To set Inbox permissions, on the Inbox pop-up menu, click the permission level that 
you want the delegate to have.  

• To set Address Book permissions, on the Address Book pop-up menu, click the 
permission level that you want the delegate  to have.  

• To send the delegate a message with the delegate information, select the Send a 
message to delegate summarizing these permissions check box. The delegate 
receives an e-mail notification of the delegation containing a description of the 
permissions that have been granted.  

7. To complete the delegation process, ask the delegate to add the owner to his or her Users I 
am a delegate for list by using the Become a delegate procedure (see Entourage Help). 

Notes 

• The delegate can accept an invitation from the owner in Outlook Web Access or in Entourage. 

Using public folders 
Public folders in Microsoft Exchange Server provide an effective way to collect, organize, and share 
information with others in an organization. Typically, public folders are used by project teams or user 
groups to share information about a common area of interest. When an Entourage user is connected 
to an Exchange server, folders labeled Public Folders appear in the Microsoft Entourage Folder List 
under the Exchange mail account. The public folder server is automatically determined when the 
Exchange account is created. The user can set or change public folder settings on the Advanced tab 
of the Exchange account. 

Note   Users can add a public folder to their favorites if they wish to automatically synchronize the 
contents of the folder and view the contents of the folder while offline. 
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Using sharing 
Users can share Address Books, Calendars, and Mail folders stored on an Exchange server with others 
on the same Exchange server. By setting permissions, a user defines which activities are allowed. 
Users can choose from a pre-defined set of permissions, or they can customize the permissions to 
accommodate how they would like to share the Address Book, Calendar, or Mail folder. 

After permission is set, those with whom the Address Book, Calendar, or Mail folder is shared can 
open it in Microsoft Entourage. When someone opens the shared Address Book, Calendar, or Mail 
folder, it is added to the Mail view and appears as a new account that contains only those Address 
Books, Calendars, or Mail folders that the user  shared. Opened Calendars and Address Books also 
appear in the Calendar and Address Book views. 

To share an Address Book, Calendar, or Mail folder, both the person sharing  and the person shared 
with must have an e-mail account on a server in the same organization that is running Microsoft 
Exchange Server 2003 or later. 

To share an Address Book, Calendar, or Mail folder 

1. Click Mail, hold down CONTROL and click the folder that you want to share with, and then 
click Sharing.  

2. Click Add User.  

3. For each user you want to receive access to the Address Book, Calendar, or Mail folder, type 
the name of the user, and then click Find.  

You can use the advanced search option if you know the domain name, account ID, and 
account type of the user whom you want receive access. 

4. Select the name of the user in the search results, and then click OK.   

5. For each user, click the user's name in the list, and then do one or both of the following:  

• On the Permission Level pop-up menu, click the level you want.  

• Select or clear the check boxes to customize permissions, and click the Edit Items 
and Delete Items levels you want. 

Note that the person shared with must open the Address Book, Calendar, or Mail folder in Entourage. 
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Creating an Address Book, Calendar, or Mail folder in an Exchange account 
Entourage 2004 allows users to create multiple Address Books, Calendars and Mail folders on the 
Exchange sever. 

To create an Address Book, Calendar, or Mail folder 

1. Click Mail, and then click an Exchange folder.  

2. Click the triangle to the right of New, and then click Folder.  

3. Type a name for the new Address Book, Calendar, or Mail folder.  

4. On the Type pop-up menu, click Address Book, Calendar, or Mail Folder.  

5. Click the location in the list where you want the Address Book, Calendar, or Mail Folder to 
appear.  

Note To create a subfolder on your Exchange account, click the folder where you want to create a 
subfolder, point to New, and then click Folder. Type a name for the new Address Book, 
Calendar, or Mail folder. On the Type pop-up menu, click Address Book, Calendar, or Mail 
Folder.  

Setting up out-of-office messages 
To configure an out-of-office response in Entourage, use Outlook Web Access. For more information, 
see Using Outlook Web Access on page 53.  

Addressing messages by using the Global Address List 
The Exchange Global Address List contains all user and distribution list e-mail addresses in your 
organization. Users can access the Global Address List in Entourage 2004 when addressing their 
e-mail. Exchange server and directory service users type the alias or name (or part of the name) and 
then click Check Names. Entourage searches the Global Address List or default directory service for 
the correct e-mail address. It then displays the Check Names dialog box, which displays all the names 
in the Global Address List that are related to the alias or name specified by the user. This search is 
also done automatically when a message is sent.  

Users can also search the Global Address List by using the Address Book list . 
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Notes 

• For browsing functionality in the GAL, the directory service server must be Windows 2003. 

• Windows 2000 and LDAP server do not support the Virtual List View mode. 

Tips 

• To display additional columns, hold down CONTROL and click the column header. 

• To quickly find a name in the GAL, select an entry in the GAL and type the first name. GAL 
scrolls to the first entry with that name. 

• To search the GAL using more options, select the directory you want to search in the Address 
Book list.  Then click Find or Command+F. To search the GAL using fewer options, click Fewer 
Options. 

• To create a new meeting request, select the person’s name from the GAL and click New 
Invite To. 

• To use AutoComplete, type names in the To box of a new e-mail message. AutoComplete 
displays a popup list of names from Contacts and Recent Addresses, the local Address Book 
and the default directory service.  

To search for an e-mail address  

1. Click Address Book. 

2. In the Address Book list, click the directory you want to search.  

3. On the pop-up menu next to the search box, click the type of search you want, and then start 
typing the name of the person or item you want in the box. For example, to find an e-mail 
address, start typing the e-mail address.  

4. In the list of search results, click an entry to view more information.  

Tips 

• To send a message to a person you find in a directory service, click the entry in the results list, 
and then click New Message To.  

• To add a person you find in a directory service to the Address Book, click the entry in the 
results list, and then click Add to Address Book.  
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Troubleshooting Entourage Exchange mail accounts 
This section discusses common issues relating to using Entourage 2004 as an Exchange client. 

Full mail addresses  
Always make certain that messages sent using the Exchange mail account use the full e-mail address 
for the account (for example, alias@microsoft.com, not just “alias”).  

Server-side issues 
The following issues might result from the server-side elements of the Entourage/Exchange solution.  

• The Global Address List is available to Entourage 2004 users only if the Active Directory (AD) 
Global Catalog (GC) server is exposed to LDAP queries. 

• If mail folders are displayed in Outlook Web Access or Outlook, but not in Entourage, there is 
an Exchange server limitation. Ensure that the latest Exchange server patches and service 
packs have been applied to the Exchange server, use Outlook Web Access or Outlook to 
rename the folders that were not displayed, and then rename them back to their original 
names. 

• An unexplained failure to synchronize messages in the Entourage error log might be the result 
of the Exchange server blocking certain DAV verbs that Entourage needs. Read Knowledge 
Base article 823175, “Fine-Tuning and Known Issues When You Use the Urlscan Utility in an 
Exchange 2003 Environment” on the Microsoft Web site at http://support.microsoft.com/, or 
send the issue to your Exchange administrator for troubleshooting. 

• The read status of public folder mails might be lost when the folder is synchronized. There is 
no workaround for this issue. 

• If users are receiving too many reminders, the Calendar preference Tentatively add events 
when invitations are received might be enabled. To eliminate this type of reminder, disable 
this preference. (This preference is disabled by default when an Exchange account is created 
in Entourage.)  

To disable the “Tentatively add events when invitations are received” preference 

1. On the Entourage menu, click Preferences. 

2. Under General Preferences, click Calendar, and then clear the Tentatively add events 
when invitations are received check box. 

http://go.microsoft.com/fwlink/?LinkId=31948&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=31948&clcid=0x409
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Ports used by Entourage 

Entourage uses port 80 for HTTP traffic (specifically, WebDAV), such as synchronizing mail, public 
folders, contacts, and events. It also uses port 443 if Secure Sockets Layer (SSL) is enabled. To locate 
the Active Directory Global Catalog server for a user account, Entourage sends DNS queries to DNS 
servers. DNS uses UDP and TCP port 53 for queries and any port number above 1023 for responses. 

Entourage uses port 135 for assigning delegate rights.  

Entourage sends LDAP queries to the Active Directory Global Catalog server to get Global Address List 
data, which uses port 3268. If for some reason your Exchange deployment uses different ports, then 
you can change them in Entourage as well. For both LDAP and Exchange accounts, specify a different 
port number in the Override default LDAP port option. 

How to reset free/busy time and reminders settings in Outlook for Mac 
If your Entourage and Outlook for Mac users are experiencing conflicts with synchronizing their 
free/busy time and reminders, you can use the following key combinations to help reset these 
settings. 

To use key combinations to achieve the desired effect with Outlook for Mac, double-click the 
application icon; immediately after the double-click, press and hold the two indicated keys. When 
you hear an acceptance tone from the computer, you can release the keys.  

• OPTION+R - Regenerates and cleans all reminders.  

• OPTION+F - Regenerates and cleans free/busy time. 

Deployment issues 
The following two deployment scenarios can result in problems for Entourage 2004: 

• Active Directory deployments where the Entourage 2004 Exchange client is unable to locate 
the Active Directory domain controllers 

• Deployments where Outlook 2003 users rename folders that are also synchronized by 
Entourage 2004 users 
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Deployments in an Active Directory infrastructure 

The Entourage 2004 Exchange client has the same Active Directory and networking infrastructure 
requirements as an Outlook Web Access client used with an Active Directory user account. The 
Entourage 2004 Exchange client must meet the following Active Directory and network infrastructure 
requirements. If these requirements are not met, the user will need to configure the Exchange mail 
account manually and provide more detailed information: 

• The Network System Preferences on the Macintosh computer running Entourage 2004 must 
be configured with the IP address of at least one DNS server. We recommend that the Search 
Domains in Network System Preferences be configured with the domain names of the Active 
Directory domain to which the user account belongs. 

• The DNS server used by the Macintosh computer must be able to return a DNS resource 
record identifying the Active Directory domain controller for the domain names it hosts. 
Alternately, the DNS server must be able to resolve the domain name the user enters for his 
or her Exchange account. In both cases, the DNS server should be able to provide name 
resolution for any name in the Active Directory namespace it supports. 

• The DNS resource records that identify the Active Directory domain controllers for the Active 
Directory global catalog server must be registered with at least one DNS server. This will 
enable the Entourage Exchange client to locate the global catalog server for the Active 
Directory forest and authenticate the user account supplied for the Exchange mail account. 

Important   In an Active Directory or network infrastructure that is heavily secured, Entourage 2004 
Exchange clients can experience difficulty in locating the Active Directory global access server and 
authenticating the user account. Environments where the servers are locked down and the required 
ports are closed will experience these problems, and Entourage auto-configure might not work. 

Differences between Entourage 2004 and Outlook for Mac 
The following list of the notable differences between Entourage 2004 and Outlook can help you plan 
Entourage 2004 deployment and diagnose Entourage issues: 

• Entourage uses the WebDAV protocol to communicate with the Exchange server and manage 
mail, Calendar, and contacts. Outlook uses a MAPI-based architecture to communicate with 
the Exchange server. 

• Entourage provides no offline access to the Global Address List. Offline, recently used 
addresses obtained from the Global Address List appear in the most recently used list 
provided in the To field of an Entourage message. 
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• Entourage does not support mapping from subscribed public folders in Entourage to public 
folder favorites in Outlook. 

• Entourage does not support Outlook forms, voting buttons, RTF message formatting, or 
receipt tracking. 

• Entourage does not support server-side rules (including out-of-office messages). Entourage 
users connecting to a server running Microsoft Exchange 2000 or later can use Outlook Web 
Access for out-of-office messages. 

• Entourage supports password expiration notification but not the ability to change the user 
account password. 

• Entourage does not support synchronizing Tasks or Notes to Exchange servers. 

Blackberry-related problems 
If Blackberry devices and Exchange 2000 Server are being used and there appears to be event 
duplication, make sure that Exchange 2000 Server has the patch mentioned in Knowledge Base 
article 313863 “XADM: Update Method Results in Duplicate Calendar Entries with Outlook 2002; 
Post Exchange 2000 SP2 Update” on the Microsoft Web site at http://support.microsoft.com/. 

Backing up data 
There are no known issues of Entourage 2004 deleting data. However, administrators might want to 
encourage users to make some Entourage X database backups before deploying Entourage 2004. 
Users can make a copy of their Entourage identity. Users can also drag Calendar and Contacts folders 
in Outlook to an archive folder before deploying Entourage 2004 to protect data. 

Calendar issues 
Entourage 2004 cannot read .msg files. This can cause problems if Outlook users drag events from 
their Outlook Calendar to an outgoing e-mail. Outlook attaches these events as .msg files, which 
Entourage 2004 cannot read. Administrators experiencing this problem can choose to instruct 
users to forward events as .ics files, which is a file format used by iCalendar and supported by 
Entourage 2004. 

Error numbering convention for HTTP-related errors  
The WebDAV protocol used by Entourage 2004 for Exchange mail accounts uses the error numbering 
convention defined by the HTTP protocol. The convention is -1900 + <HTTP status code>. For 
example, -1500 translates to 400 and is a “bad request”, and -1496 translates to 404 and is a 
“Forbidden.” For more information about status strings, see Status Code Definitions at 
http://www.w3.org/. 

http://go.microsoft.com/fwlink/?LinkId=31949&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=31949&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=31950&clcid=0x409
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This chapter covers the basics of deploying Microsoft Office 2004 for Mac, as well as the different 
deployment methods and options. Administrators can evaluate the different deployment methods and 
options to determine a deployment plan that suits their administration practices and provides the 
fewest steps for users. 

Deployment basics 
This section describes the requirements for setting up a network installation point for Microsoft 
Office 2004 for Mac, the features of the Office 2004 installer applications, and the system 
requirements for Office 2004 for Mac. 

Retail versions of Office 2004 cannot be deployed across an organization. To deploy Office 2004, your 
organization must obtain a volume license. For more information about volume licensing, see 
Licensing for Businesses on the Microsoft Web site http://www.microsoft.com/mac/. 

To learn about recommended or custom installation options and how to create a Microsoft 
Office 2004 folder for deployment, see Deployment options on page 79. To find out about the ways 
you can deploy Office 2004 in your organization, see Deployment methods on page 78.  

http://go.microsoft.com/fwlink/?LinkId=32976&clcid=0x409
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About the installers 
Deployment options for Office 2004 include both drag-and-drop installation and a Microsoft Office 
Setup Assistant application. Office installs additional fonts if necessary when a user starts an Office 
application for the first time. For more information about controlling the installation of Office fonts, 
see Controlling font installation on page 80. 

Drag-and-drop installation 
You can drag the Microsoft Office 2004 folder directly from the Office 2004 CD-ROM or a network 
folder to a local or network volume. This method results in a complete installation, the equivalent of 
choosing the Select All option in the Microsoft Office Setup Assistant. Installation is not complete until 
any one of the Office applications is started. When the first Office application is started, Office 2004 
installs additional fonts (if necessary) and collects user information. 

Microsoft Office Setup Assistant 
The Microsoft Office Setup Assistant is on the Office 2004 CD-ROM. The installer allows your users to 
select the location where the Microsoft Office 2004 folder will be created. The Microsoft Office Setup 
Assistant supports three options: Recommended Installation, Select All, and Custom Install, which 
allows you or your users to choose which components to install. 

Office 2004 system requirements 
To run Office 2004, computers must meet the following minimum requirements. 

Component Minimum requirement 

Processor PowerPC G3 or later, Mac OS X compatible processor or later 

Operating system Apple Mac OS X version 10.2.8 or later 

Memory 256 MB of RAM 

Available hard 
disk space 

484.1 MB for a recommended installation, 630 MB for a full drag-and-drop 
installation 
The hard disk should be in Mac OS Extended (HFS+) format, the default format for 
Mac OS X; although you can perform a drag-and-drop installation of and run 
Office 2004 from a hard disk that is in another format, Microsoft does not 
currently support such a configuration. To determine the format of the hard disk, 
see the Devices and Volumes tab of Apple System Profiler. 

Disk drives CD-ROM drive (or connection to a local area network if installing over a network) 

Monitor 1024 x 768 or higher resolution monitor displaying thousands of colors 

Pointing device Mouse or compatible pointing device 
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For a complete list of the system requirements for the different Office for Mac editions, see System 
requirements on the Microsoft Web site at http://www.microsoft.com/mac/. 

To use all the features available in Office 2004, we recommend that users also have the following:  

• Modem: 14.4 Kbps or higher. 

• Internet access: Internet connection through either an Internet service provider (ISP) or a 
network. Internet access might require a separate fee to an ISP; local or long-distance 
telephone charges might also apply. 

Upgrading to Microsoft Office 2004 
You can upgrade users to Microsoft Office 2004 if they are licensed users of any of the following 
Microsoft products: 

• Microsoft Office 98  

• Microsoft Office 2001  

• Microsoft Office v. X (all editions)  

• Microsoft Word + Microsoft Entourage 2001, 
Special Edition  

• Microsoft Word 98  

• Microsoft Word 2001  

• Microsoft Word X  

• Microsoft Word 2004  

• Microsoft Excel 98  

• Microsoft Excel 2001  

• Microsoft Excel X  

• Microsoft Excel 2004  

• Microsoft PowerPoint 98  

• Microsoft PowerPoint 2001  

• Microsoft PowerPoint X  

• PowerPoint 2004  

 

Unless users are licensed users of any of the preceding products, they must purchase and install the 
full version of Office 2004 to use it. 

Upgrading to Microsoft Office 2004 

During upgrade, the Office Setup Assistant might prompt you to select the location of the folder that 
contains an upgrade-eligible product (the Microsoft Office X folder, for example) if it cannot find it 
automatically. If the folder is not currently on your hard disk, you will be prompted on first launch of 
Office 2004 to locate it. If the upgrade-eligible product is on the original installation CD-ROM of that 
product, insert the CD into the computer and select the CD-ROM location when prompted. 

http://go.microsoft.com/fwlink/?LinkId=32975&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=32975&clcid=0x409
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Importing contact information to Microsoft Office 2004 

An identity stores a person's preferences, account settings, Address Book and Calendar information, 
schedules, tasks, messages, and more.  

If users previously used Microsoft Outlook Express 5.0, Microsoft Entourage 2001, or Microsoft 
Entourage X, and they have identity data on their computers, they can import one of these identities 
for use in Entourage 2004 by using the Office Setup Assistant. After you install Office 2004, users can 
also import additional identities by using Entourage 2004. To do so, open Entourage. On the File 
menu, click Import, and then follow the instructions in the Import Assistant. 

If users do not import an identity from a previous version of Entourage or Outlook Express for 
Macintosh, they will need to create a new identity, which will be used throughout the Office 2004 
programs. A user must enter at least a first and last name. This information is not sent to Microsoft. 

Deployment methods 
You can deploy Microsoft Office 2004 for Mac to your organization from a network installation point. In 
most cases, making Office 2004 available for installation from one or more network installation points 
is the easiest deployment method. 

Retail versions of Office 2004 cannot be deployed across an organization. To deploy Office 2004, your 
organization must obtain a volume license. For more information about volume licensing, see 
Licensing for businesses on the Microsoft Web site at http://www.microsoft.com/mac/. 

Deploying Office 2004 from a network installation point 
To set up a network installation point for Office 2004, you need the following: 

• A server operating system capable of handling Macintosh files (for example, AppleShare IP, 
Mac OS X Server, Microsoft Windows 2000 Server or later with AppleTalk network integration) 

• Sufficient server hard disk space for the Microsoft Office 2004 folder you want to deploy 

• The privileges necessary to create shared folders on the server and to assign privilege levels 
to them 

• The privileges necessary to create user groups and to assign users to groups 

• A license that covers the number of users for your organization 

For more information about sharing folders, see the documentation for your server operating system. 

http://go.microsoft.com/fwlink/?LinkId=32976&clcid=0x409
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To prepare the network installation point 

1. Create a folder on the server and make it accessible from the network. This folder is referred 
to as the network installation point. 

2. Copy the Microsoft Office 2004 deployment folder to the network installation point.  

To ensure that your users install the Microsoft Office 2004 folder properly, copy the Microsoft 
Office 2004 folder into the folder designated as the network installation point instead of 
making the Microsoft Office 2004 folder itself the network installation point. 

3. Set the access privileges for the network installation point. 

Your users can begin installing Microsoft Office 2004 by copying the Microsoft Office 2004 folder from 
the network installation point to their computers. 

Deployment options 
This section describes the process of creating a deployment folder that will be made available to users 
over a network for drag-and-drop installation. For information about how to deploy this folder after it 
has been created, see Deployment methods on page 78. 

Creating a recommended installation 
The recommended installation of Microsoft Office 2004 includes all Office applications and supporting 
files. 

To create a recommended Microsoft Office 2004 for Mac deployment folder 

1. Insert the Office 2004 CD-ROM into the CD-ROM drive of the local computer. 

2. Double-click Office Setup Assistant. 

3. Follow the instructions in the Assistant. 

Be sure to type the name and organization you want to use in all subsequent installations of 
Office 2004 from this deployment folder. 

After the Assistant finishes installing Office, the recommended Microsoft Office 2004 folder is ready to 
be deployed. 
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Creating a custom installation 
You can use the Custom Install option in the Microsoft Office Setup Assistant to choose applications 
and options for creating a custom Office deployment folder. 

To create a custom Microsoft Office 2004 for Mac deployment folder 

1. Insert the Office 2004 CD-ROM into the CD-ROM drive of the local computer. 

2. Double-click Office Setup Assistant. 

3. On the pop-up menu under Select the installation location, click the local volume you want. 

4. Clear the check box next to each component you do not want to include in the installation. 

5. Click Install. 

Be sure to type the name and organization you want to use in all subsequent installations of 
Office 2004 from this deployment folder. 

After the Assistant finishes installing Office, the custom Microsoft Office 2004 folder is ready to be 
deployed. 

Controlling font installation 
The first time a user opens any Office application from a user account that has never run an 
Office 2004 application, Office checks which fonts are installed. First, Office checks whether the MS 
Gothic font is installed in either the Library/Fonts folder or the Users/username/Library/Fonts folder 
and is active on the system. Then, if the MS Gothic font is not found (for example, if you or your users 
use a font management utility to temporarily enable or disable installed fonts), Office installs it along 
with additional fonts found in the Microsoft Office 2004/Office/Fonts folder. This process is called 
Runtime Installation. 

If the user account being used to run Office for the first time has Write privileges for the 
Users/username/Library/Fonts folder, Office installs the fonts into the Users/username/Library/Fonts 
folder. 

If your organization uses a centralized font management utility, and you want to avoid font conflicts 
between Office 2004 and specialized font configurations, you might want to prevent Office 2004 from 
installing any fonts during Runtime Installation.  

To prevent Office from installing fonts 

• Remove the Do Fonts file from the Microsoft Office 2004/Office folder before you deploy 
Office. 
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Configuring preferences settings 
You can include custom preferences settings for Microsoft Word, Excel, PowerPoint, and Entourage in 
your deployment. For example, you can specify the default format in which Word documents should be 
saved. By including custom preferences settings, you can ensure that each user in your organization 
has the same set of default options and settings. 

The first time an Office 2004 application is started, Office determines whether the appropriate 
settings files for the application are stored in the Users/username/Library/Preferences/Microsoft 
folder. If the Microsoft folder and the appropriate settings files are not found, the application creates 
them. If the Microsoft folder and the appropriate settings files are found, the application uses the 
preferences settings stored in the settings files. For this reason, you can deploy a standard set of 
preferences settings for Word, Excel, PowerPoint, and Entourage by deploying the Microsoft folder and 
the settings files it contains in addition to deploying the Microsoft Office 2004 deployment folder. 

Consider automating the process of deploying preferences settings by creating an AppleScript script 
file that copies your deployed Microsoft folder to each user's Preferences folder. For more information 
about AppleScript see the Microsoft Web site at http://www.microsoft.com/mac/. 

Adding custom documents, templates, scripts, and sound sets 
You can customize Office 2004 installations by adding custom documents, templates, add-ins, scripts, 
and other items to the Office 2004 deployment folder. 

To add Do this 

An Office document that will be opened 
whenever the corresponding Office 
application is run 

Copy your custom Word, Excel, or PowerPoint startup 
documents to the appropriate folders in the 
Microsoft Office 2004/Office/Startup folder. 

Custom templates to Office Copy your custom templates for Word, Excel, or 
PowerPoint to the appropriate folders in the 
Microsoft Office 2004/Templates folder. 

Custom add-ins to Excel Copy your custom add-ins to the 
Microsoft Office 2004/Office/Add-ins folder. 

Custom AppleScript scripts to Entourage Copy your custom scripts to the 
Microsoft Office 2004/Office/Entourage First Run/ 
Entourage Script Menu Items folder. 

Custom sound sets to Entourage Copy your custom sound set files to the 
Microsoft Office 2004/Office/Entourage First Run/ 
Entourage Sound Sets folder. 

 

http://go.microsoft.com/fwlink/?LinkId=22207&clcid=0x409
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This chapter provides administrators with Office 2004 for Mac configuration information that can be 
used to support the different configurations available to Microsoft® Office 2004 for Mac users. This 
chapter also covers the system and network dependencies of some of the Office 2004 features, such 
as Project Center, that administrators need to be aware of to ensure that Office 2004 users have 
access to all necessary information. 

Security updates 
Security updates for Microsoft programs for Macintosh computers can be downloaded from the 
Security updates page on the Microsoft Web site at http://www.microsoft.com/mac/. These free 
downloads are available as either an updater or as an upgrade to a new version, depending on the 
Microsoft program you are updating. 

Service releases and updates 
Service releases and updates to Office 2004 are available at the Office 2004 for Mac Support Center 
on the Microsoft Web site at http://www.support.microsoft.com/. Downloads for the different versions 
of Office for Mac can be found at the Downloads area of the Microsoft Web site at 
http://www.microsoft.com/mac/. 

Sharing printers between Macintosh and Windows clients 
To permit users of client computers that are running Mac operating systems to print, Print Services for 
Macintosh must be installed on the Windows® print server. The following procedure describes how to 
install Print Services for Macintosh on a Windows Server 2003-based computer. 

To install Print Services 

1. On the Windows Server 2003-based computer, log on as administrator or as a member of the 
Administrators group. 

2. Insert the Windows Server 2003 CD-ROM into the computer's CD-ROM or DVD-ROM drive. 
Press and hold down SHIFT as you insert the disc to prevent it from starting automatically.  

3. Click Start, point to Control Panel, and then click Add or Remove Programs. 

4. Click Add/Remove Windows Components. 

5. In the Components list, click Other Network File and Print Services (but do not select or 
clear the check box), and then click Details. 

http://go.microsoft.com/fwlink/?LinkId=32930&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=32934&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=18213&clcid=0x409
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6. On the Subcomponents of Other Network File and Print Services list, click Print Services 
for Macintosh. 

This option permits Macintosh users to send print jobs to a print spooler on the server that is 
running Windows Server 2003. If you have not already installed the AppleTalk protocol, it is 
installed automatically when you install Print Services for Macintosh. 

7. Click OK, and then click Next. 

8. Click Finish. 

Note   The Print Services for Macintosh service is not available in Windows Web Server 2003. 

Project Center 
Microsoft Office 2004 introduces the Project Center, which provides a single, consolidated view of all 
information related to a project. A project is created by using Microsoft Entourage® 2004, but a user 
can connect to the Project Center from Microsoft Word, Microsoft Excel, or Microsoft PowerPoint® by 
using the Project Palette on the Tools menu. For more information about Project Center, see “About 
the Project Center” in Entourage 2004 Help. 

Only two of the features of the Project Center require administrator assistance: 

• Sharing information   Users can invite other Entourage 2004 users to share project 
information by using a mutually accessible network file server. Each subscriber to a project 
can make changes to project data and control what is shared with others. This is different 
than sharing or delegation using an Exchange server. For more information about sharing and 
delegation using an Exchange server, see Using sharing on page 68, and Using delegation on 
page 65. 

Invitations are sent by e-mail and can be accepted only through Entourage 2004. After an 
invitation is accepted, Entourage prompts the user to log in to the appropriate network file 
server. 

• Archiving information   The Project Center allows users to back up projects and to import 
them again later. Users can save all of the information in a project, or they can choose to save 
only specific types of project information.  

Although Entourage automatically prompts users to log in to the necessary file server, administrators 
will need to provide users with access to the network file server where project information is shared 
and archived. If users are invited to a project but do not have access to the file server, they will not be 
able to join the project. 

Projects can contain sensitive information; we therefore recommend that the network file server used 
to share and archive project information require secure logon for access. Administrators will also need 
to back up the project information on the network file server periodically to ensure that no project 
information is lost. 
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Long file names 
Office 2004 supports file names that can contain up to 256 characters (file name and path combined) 
and can include any character except a colon (:) or a slash mark (/). Excel is an exception; it supports 
only 218 characters. 

Using AppleScript 
The AppleScript scripting language can be used to automate tasks on Macintosh computers. To 
extend the functionality of Word or automate repetitive tasks, you can create your own AppleScript 
scripts or applets. Any setting or configuration that can be set by using Visual Basic can be 
programmatically set by using AppleScript. These AppleScript scripts can be set to run on a scheduled 
basis. You can also use them to integrate control of other applications with Office applications using 
cross-application scripting. You can then distribute these scripts to your users, or use a script to 
automate Office 2004 deployment in your organization. For information about AppleScript, see the 
Microsoft Web site at http://www.microsoft.com/mac/. 

Configuring Word 2004 
If you are deploying Word 2004 across your organization from a network installation point, you can set 
the preferences Word 2004 uses so that each user has the same set of options and settings. For 
example, if your organization uses a set of common templates, you can store them in one location in 
a shared network folder and specify that location in Word. 

The first time each user runs Word 2004, several preferences files are created to store default 
settings such as the file format and save location. These preference settings are saved in the 
com.microsoft.Word.prefs.plist and Microsoft Office Settings (11) files in the user’s 
Library/Preferences/Microsoft folder. 

The following sections provide examples of preferences you can set for Word. After you configure Word 
with the default settings that you want, copy the com.microsoft.Word.prefs.plist and Microsoft Office 
Settings (11) files to each user's Library/Preferences/Microsoft folder. 

Locating Word components 
The various components of Word — such as styles, macros, default page settings, AutoText entries, 
AutoCorrect entries, and custom command settings — are stored either in the document itself or in an 
attached template. Some components reside strictly in the document, others reside in a template, and 
still others can be stored in either the document or a template. 

Of those components that reside in a template, some are always stored with the Normal template or 
the attached template, and others can be stored in a global template. Users can use the Organizer 
(Tools menu, Templates and Add-Ins command, Organizer button) to specify where AutoText entries, 
styles, custom toolbars, menus, keyboard shortcuts, and macros are stored. The following table shows 
where components can be stored. 

http://go.microsoft.com/fwlink/?LinkId=22207&clcid=0x409
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Component Document 
Normal or 
other template 

Global 
templates 

AutoText entries No Yes Yes 

Styles Yes Yes No 

Custom toolbars, menus, 
and keyboard shortcuts 

Yes Yes Yes 

Macros Yes Yes Yes 

Boilerplate text and graphics Yes Yes No 

Default page settings Yes Yes No 

Document text and graphics Yes No No 

Using add-ins in Word 2004 
Add-ins are supplemental programs that you install to extend the capabilities of Word by adding 
custom commands and specialized features. You can obtain add-ins from independent software 
vendors, or you can write your own custom add-in programs. 

An add-in must be loaded into Word in the same way as a global template. Like a template, the add-in 
remains available as long as Word is running. To load automatically each time Word is started, the 
add-in must be stored in the Startup folder, the location of which is specified under File Locations in 
the Preferences dialog box (Word menu, Preferences command). By default, this location is the 
Microsoft Office 2004/Office/Startup/Word folder. For more information about loading and unloading 
add-ins, see Word Help. 

Configuring Word on a computer with multiple users 
When you install Microsoft Office 2004 on a computer that does not already have a previous version 
of Office installed on it, a Normal template is created the first time you start Word. The Normal 
template is created in the user’s Documents/Microsoft User Data folder. When you configure a 
computer running Word for multiple users, you must decide whether users should each have separate 
Normal templates or should share the same Normal template. 

If you want users to share the same Normal template, make sure that all users have Read/Write 
privileges to the user’s Documents/Microsoft User Data folder. Each user will then be able to access 
and make changes to the Normal template in the user’s Documents/Microsoft User Data folder. 



 

Configuring Office 2004 for Mac 

87 

If you want each user to own a Normal template, make sure no non-administrative users have Write 
privileges to the user’s Documents/Microsoft User Data folder by changing user privileges. 

To change user privileges 

1. In the Finder, open the user’s Documents folder, select the Microsoft User Data folder, and 
then click Get Info on the File menu. 

2. Click Ownership & Permissions on the pop-up menu, and then change the permissions of 
the Microsoft User Data folder to You can = Read Only. 

After you change the user privileges, if automatic login is disabled, Word automatically saves a 
separate Normal template in the user’s Documents/Microsoft User Data folder for each user account 
that uses Word. If automatic login is enabled, non-administrative users are prompted to select a new 
save location for any changes they make to the Normal template, and Word automatically opens the 
new Normal template the next time that user logs in and starts Word 2004. 

If more than one user with administrative access uses the computer, those users must manually 
change their User Templates paths under File Locations in Preferences to another location and copy 
the Normal template to that location to maintain separate Normal templates. Otherwise, all 
administrative accounts will share the Normal template in the user’s Documents/Microsoft User Data 
folder. 

Configuring Excel 2004 
If you are deploying Excel 2004 across your organization from a network installation point, you can set 
preferences in Excel 2004 so that each user in the organization receives the same set of options and 
settings. For example, if the organization uses shared workbooks, you can specify the default file 
location where the workbooks are saved. 

Note   If the shared workbook preference is set to use a network file server, and Excel is started 
before the user connects to that server, Excel will not prompt the user to connect to the file server. 
Also, if the user checks the default file location setting in Excel Preferences while not connected to the 
network file server, the preference appears to be blanked out. 

The first time each user runs Excel 2004, several preferences files are created to store default 
settings, such as the file format and save location. These preferences settings are saved in the 
com.microsoft.Excel.prefs.plist and Microsoft Office Settings (11) files in the user’s 
Library/Preferences/Microsoft folder. 

After you configure Excel with the default settings that you want, copy the 
com.microsoft.Excel.prefs.plist, Excel Toolbars (11), and Microsoft Office Settings (11) files to each 
user’s Library/Preferences/Microsoft folder. 
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Excel specifications and limitations 
Microsoft Excel 2004 has the following specifications and limitations. 

Workbook and worksheet specifications  

Feature Maximum limit 

Open workbooks Limited by available memory and system 
resources 

Worksheet size 65,536 rows by 256 columns 

Column width 255 characters 

Row height 409 points 

Length of cell contents (text) 32,767 characters (only 1,024 display in a 
cell; all 32,767 display in the formula bar) 

Sheets in a workbook Limited by available memory 

Colors in a workbook  56 

Cell styles in a workbook 4,000 

Named views in a workbook Limited by available memory 

Custom number formats Limited by available memory 

Names in a workbook  Limited by available memory  

Windows in a workbook  Limited only by system resources  

Panes in a window  4  

Linked sheets  Limited by available memory 

Scenarios Limited by available memory; a summary 
report shows only the first 251 scenarios 

Changing cells in a scenario 32 

Adjustable cells in Solver 200 

Custom functions Limited by available memory  

Zoom range 10 percent to 400 percent 

Reports Limited by available memory  

Sort references 3 in a single sort; unlimited when using 
sequential sorts 
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Feature Maximum limit 

Undo levels 16 

Fields in a data form 32 

Custom toolbars in a workbook Limited by available memory 

Custom toolbar buttons Limited by available memory 

Calculation specifications  

Feature Maximum limit 

Number precision  15 digits 

Largest allowed positive number 9.99999999999999E307 

Smallest allowed negative number -9.99999999999999E307 

Smallest allowed positive number 1E-307 

Largest allowed negative number -1E-307 

Iterations 32,767  

Worksheet arrays Limited by available memory 

Selected ranges  2,048  

Arguments in a function  30 

Nested levels of functions 7 

Number of available worksheet functions  329 

Earliest date allowed for calculation January 1, 1900 (January 1, 1904, if 1904 
date system is used) 

Latest date allowed for calculation December 31, 9999 

Largest amount of time that can be entered 9999:99:99 
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PivotTable report specifications  

Feature Maximum limit 

PivotTable reports on a sheet Limited by available memory 

Items in a PivotTable report 8,000 

Row or column fields in a PivotTable report Limited by available memory 

Page fields in a PivotTable report 256 (may be limited by available memory) 

Data fields in a PivotTable report 256 

Calculated item formulas in a PivotTable report Limited by available memory 

Pages in a PivotTable report 8,000 

Charting specifications  

Feature Maximum limit 

Charts in a workbook  255  

Charts linked to a worksheet  Limited by available memory  

Worksheets referred to by a chart  255 

Data series in one chart  255 

Data points in a data series for 2-D charts  32,000 

Data points in a data series for 3-D charts  4,000 

Data points for all data series in one chart 256,000 

Maximum number of fonts in a chart  255 

Line styles  8  

Area patterns (screen display)  18 

Total area pattern and color combinations (color 
display)  

56,448 

Pattern and color combinations (color printer) 56,448 (the actual number depends on 
your printer and its software) 
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Workgroup specifications  

Feature Maximum limit 

Users who can open and share a shared 
workbook at one time 

256 

Personal views in a shared workbook Limited by available memory 

Days that change history is maintained 32,767 (default is 30 days) 

Workbooks that can be merged at one time Limited by available memory 

Cells that can be highlighted in a shared 
workbook 

32,767 

Colors used to identify changes made by 
different users when change highlighting is 
turned on 

32 (each user is identified by a separate 
color; changes made by the current user are 
highlighted with navy blue) 

 

Importing information in Excel 2004 
Microsoft Excel 2004 for Mac offers several features that enable you to manage data and connect to 
various data sources. This section describes some of the features that you and your users can use to 
maintain and share data in Excel. 

Importing data from a FileMaker Pro database 

Excel 2004 provides a FileMaker Import Wizard that you can use to import or convert FileMaker Pro 
databases to Excel. The FileMaker Import Wizard is available only to users who have FileMaker Pro 
installed. 

When users access a FileMaker Pro database in Excel by clicking Open on the File menu, the 
FileMaker Import Wizard starts and allows them to convert their data so that they can maintain it in 
Excel. There are some limitations on importing data from a FileMaker database into an Excel 
workbook.  

Users can also use the FileMaker Import Wizard to set up a query to a FileMaker Pro database. By 
clicking Import from FileMaker Pro (Data menu, Get External Data command), they can bring data 
from the database into Excel without having to convert the database. They can maintain the data in 
FileMaker Pro and update it in the Excel workbook by clicking Refresh Data on the Data menu. 

Importing data by using Open Database Connectivity (ODBC) 

ODBC support is not included with Excel 2004. Excel for Mac cannot import data from OLE DB or OLAP 
data sources. For the latest information about ODBC support, visit the Microsoft Web site at 
http://www.microsoft.com/mac/. 

http://go.microsoft.com/fwlink/?LinkId=24747&clcid=0x409
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Importing and refreshing data from a text file 

Users can bring data from text files into Excel the same way that they create other database queries. 
Formatting and formulas are retained when the user opens the file as refreshable. By clicking Import 
Text File (Data menu, Get External Data command), the user starts the Text Import Wizard and is 
then able to create an External Data Range. This query is similar to a regular database query and can 
be used to retrieve and refresh data from the original text file. For more information about refreshing 
external data, see Excel Help. 

Using Web queries in Excel 2004 

A Web query retrieves data stored on the Internet or an intranet. For example, you can create a Web 
query that retrieves a current product price from a database on your intranet. Excel 2004 includes 
sample Web queries that you can modify by changing the text in any text editor. You can find these 
samples in Microsoft Office 2004/Office/Queries. To retrieve external data from a Web source, users 
must have access to the Internet or an intranet, depending on the location of the data source. To run a 
Web query, users click Run Saved Query (Data menu, Get External Data command), locate the query 
they want to run in the Choose a Query dialog box, and then click Get Data. 

Using add-ins with Excel 2004 
Add-ins are programs that add optional commands and features to Excel. For example, the Analysis 
ToolPak add-in provides a set of data analysis tools that can save steps when you develop complex 
statistical or engineering analyses. 

Some add-ins are installed and loaded automatically; other add-ins are installed only and must be 
loaded into Excel manually. The standard Excel add-ins are installed and loaded by default. To install 
an add-in manually, click Add-Ins (Tools menu), and then click Select. After an add-in is installed, it 
appears on the Add-Ins available list in the Add-Ins dialog box (Tools menu). 

Next, the add-in must be loaded into Excel. Loading an add-in makes the feature available in Excel and 
adds any associated commands to the appropriate menus. To load an add-in, select the check box 
next to the add-in on the Add-Ins available list. Users can also load an add-in for only the current 
Excel session by opening the add-in (File menu, Open command). 

Some add-ins are not loaded in the Add-ins dialog box, but are added as regular menu items, such as 
Conditional Sum Wizard, Lookup Wizard, Report Manager, and Solver. 

To conserve memory and improve performance, unload add-ins that your users do not use very often. 
Unloading an add-in removes its features and commands from Excel but does not remove the add-in 
file from its original location or from the Add-Ins available list. To unload an add-in, clear the check 
box next to the add-in on the Add-Ins available list. When you unload an add-in, it remains in memory 
until you restart Excel. 

Users can also save workbooks as add-ins. Once they are created, add-ins are protected because they 
cannot be edited. You can create add-ins to assemble and distribute custom features that, from the 
user's point of view, appear as if they are built into Excel. To create an add-in from the workbook, click 
Save As on the File menu, and then click Microsoft Excel Add-In on the Format pop-up menu. 
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Excel 2004 recognizes files with file type "XLA8" or file extension .XLA as add-ins compiled from Excel 
workbooks. Add-ins can also be written in C code. When they are compiled from C code, add-ins 
should have the file type "XLL8" or the file extension .XLL. 

The following add-ins are included on the Office 2004 CD and are already installed in Excel 2004: 

Add-in Files Description 

Analysis 
ToolPak 

Analysis ToolPak 
FuncRes 
ProcDBRes 

Adds financial, statistical, and engineering analysis tools and 
functions. 

Analysis 
ToolPak VBA 

Analysis ToolPak 
- VBA 

Includes VBA functions for Analysis ToolPak. 

Conditional 
Sum Wizard 

Conditional Sum 
Wizard 

Creates a formula that sums data in a list if the data matches 
criteria users specify. This add-in must be loaded. 

Euro Currency 
Tool 

Eurotool.xla 
EuroConvert 
Library 

Converts euro currency between ISO member countries.  

Internet 
Assistant VBA 

HTML.XLA Runs macros that use the legacy HTMLConvert function.  

Lookup Wizard Lookup Wizard Creates a formula to look up data in a list by using another known 
value in the list. This add-in must be loaded. 

Report Manager Report Manager Creates reports that contain different print areas within the 
workbook, custom views of the workbook, and scenarios. This 
add-in must be loaded. 

Set Language Set Language Sets the current proofing language.  

Solver Solver.xla 
Solver Library 

Calculates solutions to what-if scenarios based on adjustable cells 
and constraint cells. This add-in must be loaded. 

 

Notes  

• The Add-Ins folder contains other files in addition to the files for add-ins listed here. Users 
do not need to load these additional files because they are loaded when Excel is installed. 

• If the source workbook for an add-in contains a reference to another add-in, make sure that 
when the add-in is distributed, the referenced add-in is stored on the user's computer where 
the calling add-in can find it. The best strategy is always to store a referenced add-in in the 
folder that contains the calling add-in. When a source workbook is compiled as an add-in, 
Excel stores a path to the referenced add-in in the calling add-in. 
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Configuring PowerPoint 2004 
You can provide users with a custom template so that their PowerPoint presentations include design 
elements specific to your organization. If you are deploying PowerPoint 2004 across your organization 
from a network installation point, you can set preferences in PowerPoint 2004 so that each user in the 
organization receives the same set of options and settings. For example, if the organization uses 
shared presentations, you can specify the default file location where the presentations are saved. 

The first time each user runs PowerPoint 2004, several preferences files are created to store default 
settings, such as the file format and save location. These preferences settings are saved in the 
com.microsoft.PowerPoint.prefs.plist and Microsoft Office Settings (11) files in the user’s 
Library/Preferences/Microsoft folder. 

After you configure PowerPoint with the default settings that you want, copy the 
com.microsoft.PowerPoint.prefs.plist and Microsoft Office Settings (11) files to each user’s 
Library/Preferences/Microsoft folder. 

Configuring Entourage 2004 
This section describes how to administer Microsoft Entourage 2004 for Mac for users in your 
organization, including working with the Entourage database and importing data to Entourage 2004. 

The Entourage Identity database 
The first time Microsoft Entourage 2004 is started, the Microsoft User Data folder is created in the 
Documents folder. The database for each identity is stored in its own folder inside the Microsoft User 
Data/Office 2004 Identities folder. The following information is stored in the database (depending on 
whether Microsoft Office 2004 or stand-alone versions of Word, Excel, or PowerPoint were installed): 

• All Entourage data, such as messages, schedules, tasks, contacts (including the Microsoft 
Word Address Book), and preferences  

• Project Palette data  

• Scrapbook clips  

You can move the entire Microsoft User Data folder or only the folder for any single identity, to a 
different location, such as to another hard disk attached to the computer or to a network; however, if 
the folder is moved, an alias to the folder must be placed in the folder's original location. Otherwise, 
Entourage will not be able to find the user data. 
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Using the Database Utility 

The Database Utility, located in the Microsoft Office 2004/Office folder, is a tool for checking, 
compacting, and rebuilding the Microsoft Entourage Database. If any of the following problems 
appear, the database might be damaged and might need to be rebuilt: 

• Entourage will not start or crashes.  

• Entourage items will not open or the item that opens is not the item that you double-clicked.  

• Blank lines appear in the Entourage message list or Word Address Book.  

• Word Address Book entries are not displayed properly.  

• The clips in the Scrapbook disappear.  

• In Entourage, information that was added, such as a Calendar event or a contact, cannot 
be found.  

• In an Entourage search, the search results do not match the criteria that were set.  

• A blank Office Notifications window appears.  

If Entourage detects a problem with the database after checking for damage, it automatically starts 
the Database Utility. If you suspect that the database is damaged, try to ascertain the source of the 
problem before you attempt to fix it. It is possible that repairing the database could cause data loss, 
and it is therefore important that you first make sure that you did not accidentally cause the 
symptom — for example, by moving a message to the wrong folder. Also, make sure that the problem 
is not the result of general computer problems, such as a damaged or fragmented hard disk. To do so, 
run a disk diagnostics and repair program, such as Apple Disk Utility. For more information about 
identifying and repairing hard disk problems, see the documentation for the disk utility program. 

To check the integrity of the Entourage database  

1. If you have not done so, quit all Microsoft Office programs, including Microsoft Entourage and 
Office Notifications.  

2. Double-click the Database Utility program located in the Office folder, or hold down the 
OPTION key while starting Entourage.  

3. Click the Identity of the database you want to check.  

4. Click Verify database integrity, and then click Continue.  

5. Follow the instructions on your screen. 
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To rebuild the Entourage database  

1. If you have not done so, quit all Microsoft Office programs, including Microsoft Entourage and 
Office Notifications.  

2. Double-click the Database Utility program located in the Office folder, or hold down the 
OPTION key while starting Entourage.  

3. Click the Identity of the database you want to rebuild.  

4. Click Rebuild database, and then click Continue.  

5. Follow the instructions on your screen. 

When you rebuild the database, Entourage does not modify the existing database. It makes a copy of it 
and rebuilds and compacts the copy. After the rebuild process is complete, there will be two folders in 
the Identities folder related to the identity that was rebuilt, one with the newly rebuilt database in it 
and one with a backup copy of the database before it was rebuilt (for example "Main Identity" and 
"Main Identity [Backed up date and time]"). The backup copy will have the date and time of the rebuild 
after its name. If the computer does not have enough free disk space to store both your current 
database and a copy of it, an out-of-memory error occurs. For example, if the current size of the 
database is 10 megabytes (MB), at least 20 MB of free disk space is needed to rebuild the database. 

Back up and restore the Entourage database  

A backup copy can be made of the entire Microsoft User Data folder or of only the folder for any single 
identity. If there is a problem starting Microsoft Entourage or opening data, first try rebuilding the 
database. If problems continue, restore the data from the backup copy. 

To back up the Entourage database 

1. Locate the existing folder that you want to back up: Documents/Microsoft User Data/Office 
2004 Identities/<identity name>.  

2. Copy the folder to another location, such as to a different local or network hard disk, a 
high-capacity storage disk, or removable media such as (Compact Disk Recordable) CD-R.  

To restore the Entourage database 

1. Locate the existing folder that you want to replace with a backup copy: 
Documents/Microsoft User Data/Office 2004 Identities/<identity name>.  

2. Drag the folder to the Trash.  

3. Locate the copy of the folder that you created, and then drag it to the former location in the 
Documents folder of the folder you are replacing. 
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To compact and back up the Entourage database 

1. If you have not done so, quit all Microsoft Office programs, including Microsoft Entourage and 
Office Notifications.  

2. Double-click the Database Utility program located in the Office folder, or hold down the 
OPTION key while starting Entourage.  

3. Click the Identity of the database you want to compact and back up.  

4. Click Compact database, and then click Continue.  

5. Follow the instructions on your screen.  

Helping users configure Entourage 
To help users get started with Entourage, you can do one of the following: 

• Provide them with the setup information they need to configure Entourage themselves. 

• Provide them with a default setup folder to ensure that each user configures Entourage the 
same way. 

Providing setup information to users 

When your users start Entourage for the first time, the Entourage Setup Assistant appears and leads 
them through the process of entering their personal information and setting up a mail account. If they 
send and receive messages by using mail accounts that you administer, make sure each user has the 
following required information: 

• An e-mail address 

• The mail server's protocol 

• An account ID, the part of the e-mail address before the at sign (@) 

If a user sets up a mail account that you do not administer, the information must be obtained from the 
user's Internet service provider (ISP). 

Users might also need the following networking information: 

• TCP/IP settings   To connect to the Internet, users might need to adjust the settings in the 
Network preferences pane in System Preferences (Apple menu). 

• Proxy server settings   If your organization uses a proxy server to send and receive 
messages, users can enter the settings in the Network preferences pane in System 
Preferences (Apple menu). 

• Security settings   Depending on how the mail server is configured, users can specify more 
than the default level of security by setting some of the advanced sending and receiving 
options. 
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For more information about Entourage 2004 security options, see the Office 2004 for Mac Security 
chapter on page 15. 

Users can then finish configuring Entourage by setting preferences (Entourage menu, Preferences, 
then General Preferences and Mail & News Preferences), creating signatures (Tools menu, 
Signatures), and creating rules (Tools menu, Rules). 

Providing a default setup folder for users 

You can automate the setup process for new users by creating a folder that contains the default 
information they need. When you do so, Entourage uses the information you provided instead of 
starting the Entourage Setup Assistant the first time a new user starts Entourage. 

To provide a setup folder for users, start by creating a standard installation or a custom installation. 
Next, start Entourage to automatically create the Microsoft User Data folder in the user’s Documents 
folder. Within the Microsoft User Data folder, Entourage creates a folder that stores all the data for the 
active identity. Use the Account Setup Assistant to configure accounts with information that is the 
same for all users (for example, server addresses, advanced sending and receiving options, and the 
address of a company Exchange and LDAP server). You must enter an e-mail address to complete the 
Account Setup Assistant, so you should enter a temporary placeholder e-mail address that your users 
can change later. 

Tip   You can also configure Entourage in other ways; for example, you can create a default signature 
(Tools menu, Signatures command), set options in the Preferences dialog boxes (Entourage menu, 
General Preferences and Mail & News Preferences commands), or create a set of default rules 
(Tools menu, Rules command). 

When you have finished configuring Entourage, copy the Microsoft User Data folder created in the 
current user's Documents folder and then distribute it to new users. The folder must be copied to the 
new user's Documents folder before Entourage is started for the first time. If users start Entourage 
before the Microsoft User Data folder is copied to their computers, Entourage will create a Microsoft 
User Data folder that does not contain the information you entered. 

Make sure that new users complete the setup process by adding their own information after starting 
Entourage for the first time. For example, if you created a default mail account, users can double-click 
the account in the Accounts window (Tools menu, Accounts command) to add the following account 
information: name, e-mail address, account ID, and password. Also make sure that users complete the 
information in the contact that includes their own information (the Me contact). Users who do not 
complete this information will not be able to use some features of Office, such as getting driving 
directions in Entourage or displaying their own return address in a letter or envelope created in Word. 

Importing data to Entourage 2004 
If your organization is switching to Microsoft Entourage 2004 for Mac from a different e-mail 
application or personal information manager (PIM), users can import information that they created in 
other applications, including contacts, calendar events, notes, tasks, messages, rules, signatures, and 
account information. 
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Importing data from another application 

Users can import information such as messages, contacts, calendar events, tasks, and rules directly 
from these applications: 

• Microsoft Entourage X 

• Microsoft Entourage 2001  

• Microsoft Outlook Express (5.0 or later)  

• Qualcomm Eudora (any version)  

• Netscape Communicator (versions 4.X only)  

• Claris Emailer 2.0v3  

• Now Contact (3.8 or later)  

• Now Up-To-Date (3.8 or later)  

To import data to Entourage 2004, users can click Import on the File menu and then follow the 
instructions in the Import Assistant. 

Users can continue to use their previous e-mail application or PIM even after importing data to 
Entourage. If users plan to use only Entourage to send and receive messages and manage their 
personal information, they can remove the previous mail application from their computers. However, 
users should make sure that all of their data has been successfully imported to Entourage before 
removing the previous application. 

Importing .PST files from Microsoft Outlook 2001 for Mac 

Microsoft Outlook 2001 for Mac users can import their .pst files into Entourage 2004 by using the 
PST Import Tool. 

To import Outlook 2001 for Mac PST files into Entourage 

1. On the www.microsoft.com/mac Web site, click Downloads, and then download the 
PST Import Tool for Entourage 2004 for Mac.  

2. Make sure Entourage 2004 is running.  

3. Double-click PST Import Tool.  

4. Follow the steps in the wizard to select a PST file and import it into Entourage 2004. Users 
can specify the types of data (such as e-mail messages or Calendar items) to import.  

Important   The PST Import Tool imports only PST files that were created in Outlook 2001 for Mac. 

If the user switches Entourage identities during the import process, the import process stops 
responding. If this happens, the user needs to double-click PST Import Tool again.  

To import a PST file by using the PST Import Tool, the user must have read permissions for the 
PST file.  

When the PST Import Tool is downloaded, a Help file is also downloaded.The PST Import Tool Help file 
can help users diagnose problems with the PST Import Tool.  
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Importing data from Microsoft Entourage X or 2001 

Custom Views that filter on more than one area will be imported into the new Custom Views area of 
Entourage 2004. Custom Views that filter on only one area (Mail, Address Book, Calendar, and so on) 
will be imported into the Custom Views section of that area. Also, folder synchronization settings for 
schedules that receive messages from IMAP and Hotmail® accounts are not imported. The user must 
reenter folder synchronization settings for such schedules. 

Importing data from Microsoft Outlook Express 5 

If the user selected default fonts for displaying, creating, or printing items in Outlook Express — for 
example, if he or she selected the default font for messages in HTML format — the user must restart 
Entourage after the import process is complete to update these settings in Entourage. 

If the user selected an AppleScript script to run as part of a rule, schedule, or action by the Junk Mail 
Filter in Outlook Express, the script must be updated to work with Entourage. This can be as simple as 
opening the script in the Script Editor and replacing "Outlook Express" with "Microsoft Entourage" in 
any "tell application" statements in the script. After the script has been updated, the user must open 
the rule, schedule, or Junk Mail Filter in Entourage, and then select the updated script. 

Importing data from Microsoft Outlook Express 4.5 

Entourage 2004 does not support importing data directly from Outlook Express 4.5 or earlier. To 
import this data, first upgrade to Outlook Express 5, and then import the data from Outlook Express 5 
to Entourage. 

Importing data from Apple Mail 

Entourage 2004 does not support importing data directly from Apple Mail.  

Importing data from Qualcomm Eudora (any version) 

Because Entourage 2004 does not import the status of messages (whether they are read or unread), 
the status of all imported messages will be marked as unread in Entourage. After the message import 
process has finished, the user can quickly mark all of the messages as read. To do so, the user clicks 
the imported folder in the Folders list, and then clicks Mark All as Read on the Message menu. 
Additionally, Entourage does not maintain links between imported messages and their attachments; 
however, the attachments are stored in the user’s Documents/Microsoft User Data/Saved 
Attachments folder. 

Importing data from Netscape Communicator 4.X 

During the import process, when users are asked to select the Netscape user’s folder that contains 
the data they want to import, make sure they select the folder that contains their profile folder (the 
Netscape user’s folder), not the profile folder itself. If the user has stored his or her profile folder in 
a different location — for example, in the user's Documents folder — select that folder instead. 
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Importing data from Claris Emailer 2.0v3 

When users import data from Claris Emailer, Microsoft Entourage automatically starts Emailer; Emailer 
must be running for Entourage to import data from it. 

If users have problems importing data from Claris Emailer, try assigning more memory to Emailer by 
using the Get Info dialog box in the Finder. For more information about assigning more memory to a 
program, see Mac Help in the Classic environment. After you have assigned more memory to Emailer, 
start both Emailer and Entourage, and then begin the import process again. 

Because account settings, priorities, rules, mail actions, and schedules cannot be imported from 
Claris Emailer, users will need to re-create these items in Entourage. Additionally, Entourage does not 
maintain links between imported messages and their attachments, but the attachments are stored in 
the user’s Documents/Microsoft User Data/Saved Attachments folder. 

Importing data from Now Contact or Now Up-To-Date 3.8 or later 

When users import data from Now Contact or Now Up-To-Date, Entourage 2004 automatically starts 
Contact or Up-To-Date and opens the default data file for the program. However, in some cases users 
should manually start Contact or Up-To-Date and open the data file that contains the data they want to 
import before they start the import process in Entourage. Users need to start the program manually if:  

• They have created more than one data file for Contact or Up-To-Date. 

• They try to import data and the import stalls, alerts them of an AppleEvent timeout, or 
does not import any data. 

Similarly, if users are using a trial version of Now Contact or Now Up-To-Date, be sure they manually 
start the program and, before they start the import process in Entourage, dismiss the initial dialog box 
that prompts them to register the program. 

Because categories cannot be imported from Now Contact and Now Up-To-Date, users will need to 
recreate their categories in Entourage. To do so, users can point to Categories on the Edit menu, and 
then click Edit Categories. Also, some types of attachments for contacts and events cannot be 
imported. 

Importing data from other programs, such as Microsoft Outlook 2000 

Users can directly import data only from the programs listed above. However, users can import 
contacts and messages from other programs by first exporting the contacts or messages from the 
other program in a format that Entourage understands, and then importing them to Entourage. For 
example, users can export contacts from Microsoft Outlook 2000 as a tab-delimited text file and then 
import the file to Entourage. For more information about exporting data from a specific program, see 
the documentation for the program. 
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Importing data from a text file 

If your organization is switching to Entourage from an application that is not listed above, users can 
also import the following types of data from a text file: 

• Contacts   A user can import contact information from a text file that was exported from any 
application, including spreadsheet and database programs. The text file must be exported in 
tab-delimited or comma-delimited format. For more information about exporting contacts to a 
text file, see the documentation for the source application. 

Before importing the contact information, the user can specify how data fields in the source 
application correspond to fields in Entourage. For example, if the source application contains 
a field called Business Phone, the user can specify that the data in that field is imported to a 
work phone field in Entourage. For more information about importing contacts from a text file, 
see Entourage Help. 

• Messages   A user can import messages that have been saved as an MBOX-format text file, 
a format commonly used by UNIX-based systems. An MBOX-format text file is a single file that 
can contain many messages. When the user imports an MBOX-format text file to Entourage, 
the imported messages appear in a new folder in the Folder list. Users can quickly import an 
MBOX-format text file by dragging the file from the Finder to the Entourage Folder list. 

You can also use the Entourage text importing features to provide standard data to all of your users. 
For example, you can create a tab-delimited or comma-delimited text file that contains contact 
information for members of your organization and distribute it when you deploy Office 2004. 

Handheld synchronization 

If users have handheld devices, they can synchronize, or share, items between Entourage and the 
handhelds. When synchronizing, Entourage copies contacts, tasks, notes, and Calendar events to and 
from the handheld. After the user enters information, the user can view or change it by using either 
the computer or the handheld. 

If users are using Palm Desktop to store information, they can import this information into Entourage 
by synchronizing the handheld device with Palm Desktop so that it has the latest information. 

Palm Desktop 4.0 is required for Handheld Synchronization to work properly. If the handheld does not 
support Palm Desktop 4.0, Handheld Synchronization with Entourage will not work. For more 
information, check with the handheld manufacturer. 

To synchronize a handheld device 

1. Make sure that Palm Desktop 4.0 is installed on your computer.  

2. Install the Handheld Sync Installer (Entourage Conduit). To do so, open the Microsoft Office 
2004/Additional Tools folder. Double-click Handheld Sync Installer, and then follow the 
directions on your screen.  

3. In HotSync Manager, make sure that the Entourage Conduit is set up to synchronize. For more 
information, see HotSync Manager Help.  

4. Synchronize the handheld device with Entourage by using HotSync Manager.  
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Complex HTML 
In Entourage 2004, users can receive messages that use complex HTML, which adds special 
formatting, such as tables, navigation menus, or other effects, to a message. Although users can 
receive complex-HTML messages in Entourage, they cannot create them. To send e-mail messages in 
HTML, users can use Word. For more information, see Word Help. 

Complex HTML is most frequently used by organizations to send newsletters, Web pages, and 
announcements as messages. However, it can be used by anyone to run scripts or download files that 
might harm computers or pose a risk to users' privacy. To help ensure that users remain safe from 
malicious software, Entourage does not run scripts or download files that are specified by 
complex-HTML messages. This does not alter the user’s ability to read the complex-HTML 
message itself.  

Because complex-HTML messages contain special formatting, they typically take longer to display 
when you open or preview them. Therefore, users might want to disable complex HTML by using the 
following procedure. 

To enable or disable complex HTML in incoming messages 

1. On the Entourage menu, click Preferences.  

2. Under General Preferences, click Security.  

3. Under HTML options, select or clear the Display complex HTML in messages check box.  

Tip   If you disable complex HTML, all of the special formatting contained in complex-HTML messages, 
such as pictures and tables, is removed when you open or preview them. 

Compatibility reporting 
Microsoft Office 2004 Compatibility Report identifies and helps users fix items in a document that 
might not display or print properly in earlier versions of Office for Mac, or in versions of Office for 
Windows. If your users share their documents with users of other versions of Office, Compatibility 
Report helps ensure that these documents appear as expected when they are opened. Users can 
use Compatibility Report in Word, Excel, and PowerPoint by clicking Compatibility Report on the 
Tools menu. 
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Checking for compatibility 
When a document is opened, Compatibility Report automatically checks for compatibility with Office 
97 through Office 2004. It also performs automatic background checks for compatibility as users are 
working in a file. If an issue is found, the Toolbox button glows, and users can click the Toolbox button 
to open the Compatibility Report window and review the issues. Compatibility Report also alerts users 
to issues when a document is first saved, and when users click Save As on the File menu. 

Compatibility Report can be configured to check for issues with specific versions of Office by clicking a 
version of Office on the Check compatibility with pop-up menu. 

In some cases, Compatibility Report is not able to scan the entire document for issues. To ensure that 
all of the content in a document is checked, have users click Check/Recheck Document. 

Resolving compatibility issues 
Users can click an item on the Results list to view an explanation of the issue that was found. In 
addition, the object or content that is affected by the issue is selected in the document. If more than 
one item in the document is affected by the same compatibility issue, the issue is listed on the 
Results list for each affected item in the document. 

To fix the selected issue, click Fix. To fix all instances of the issue that is selected on the Results list, 
click the arrow next to Fix, and then click Fix All. 

If the issue is not important, click Ignore. To ignore all instances of the issue that is selected on the 
Results list, click the arrow next to Ignore, and then click Ignore All. To ignore this issue in all 
documents, click Never Show Again. 

To learn more about the compatibility issue, see Office Help. If no fix is available, Help often contains 
information about how to work around the issue. 

Setting Compatibility Report options 
You can turn off automatic checks for compatibility issues. On the Application menu (Word, Excel, or 
PowerPoint), click Preferences. in the Preferences dialog box, click Compatibility, and then clear the 
Check documents for compatibility check box. To reset the list of compatibility issues you've chosen 
to ignore, click Reset Ignored Issues. To reset the list of ignored issues, including the list of issues 
you chose never to show again, click Reset All Issues. 

International Features of Office 2004 
Microsoft Office 2004 for Mac programs support editing and viewing documents in many languages. 
If your users work with documents that contain text in more than one language or if users share 
documents with people who use Office on systems that run in other languages, you or your users can 
customize Office 2004 to manage conventions and requirements unique to each language. 

Each of the applications in the English version of Office 2004 has features that enable users to create, 
view, and edit documents in languages other than English. 
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Office 2004 shared international features 
Unicode support   Office 2004 applications support the input, display, and basic editing of Unicode 
characters associated with the following keyboards: 

Australian, Austrian, Belgian, Brazilian, British, Bulgarian, Canadian, Catalan, Cherokee, Chinese 
(Simplified), Chinese (Traditional), Croatian, Czech, Danish, Dutch, English, Estonian, Faroese, Finnish, 
French, German, Greek, Korean, Hawaiian, Hungarian, Icelandic, Inuktitut, Irish, Italian, Japanese, 
Latvian, Lithuanian, Macedonian, Norwegian, Northern Sami, Polish, Portuguese, Romanian, Russian, 
Serbian, Serbian-Latin, Slovak, Slovenian, Spanish, Swedish, Swiss French, Swiss German, 
Turkish, Ukrainian, Welsh.  

Inputs of the above languages are also supported through the following system-level Unicode input 
methods: Unicode Hex Input, US Extended, and the Character Palette.  

Note   Installing Office 2004 on a version of the Mac OS for any of the supported languages except 
Japanese also enables the multiple-language features of Office 2004. 

International proofing tools   International proofing tools for each of the supported languages are 
installed in the Microsoft Office 2004/Shared Applications/Proofing Tools folder. The proofing tools for 
European languages allow Office to hyphenate according to the rules of the language and to check the 
spelling of text. The proofing tools also include a thesaurus for each language and a German grammar 
checker. British, Australian, and U.S. English proofing tools are included in the English version of 
Office 2004. The Japanese proofing tool component included in the Microsoft Office 2004/Shared 
Applications/Proofing Tools folder with non-Japanese versions of Office 2004 provides Japanese rules 
for full grammar and consistency checking. 

Multilingual Web pages   Users of Word, Excel, and PowerPoint can specify the default character set 
encoding when they save documents as Web pages.  

To specify the default character set 

1. On the File menu, click Save As. 

2. On the Format pop-up menu, select Web Page (HTML). 

3. Click Web Options, and then click the Encoding tab. 

4. Select an option on the Save this document as pop-up menu.  

Sorting rules for multiple languages   Office 2004 applications sort data in tables and lists according 
to the rules of the currently selected language in Mac OS X, which is selected by using the 
International pane in System Preferences (Apple menu). This includes Japanese when the 
application is registered for using Japanese characters. To do so, use the Microsoft Language 
Register. 
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Correct date, time, and number style   When you enter dates, times, and numbers, Office 2004 
applications can format them in the correct style for different languages. Office 2004 supports 
international date and time formats. 

Euro support   All Office 2004 applications offer full support for entering, displaying, and printing euro 
currency values. Excel 2004 provides support for performing financial calculations involving the euro. 

German post-reform spelling rules   Users can set Word, PowerPoint, and Entourage 2004 
preferences to use German post-reform spelling rules when checking the spelling of German text. 

International features of Entourage 2004 
Japanese contact format   By using Japanese contact format, users can enter furigana (characters 
used to indicate pronunciation) for contact information such as a contact's first, last, and company 
names. Users can also keep track of greeting cards they have sent to or received from a contact 
according to year. In addition, Japanese contact format changes the order of some name and address 
fields and removes others, such as the Postal code field, so users can enter and store Japanese 
addresses correctly. 

Lucky days   The Entourage Calendar can display lucky days. Users can choose between displaying 
specific lucky days or all lucky days. 

Support for Japanese text   By using an input method editor (IME), users can type Japanese text in 
messages, tasks, and other items. This feature is available if you use the International pane in 
System Preferences (Apple menu) to turn on the Japanese keyboard layout and set the Mac OS to 
Japanese. Users can also enable this feature by registering Entourage with the Microsoft Language 
Register for use with the Japanese language. 

International features of Word 2004 
The Microsoft Proofing Tools are installed in the Microsoft Office 2004/Shared Applications/Proofing 
Tools folder. After Japanese language support is enabled, users can edit text as follows: 

• Check spelling and grammar according to the rules of another language. 

• Look up words in the thesaurus of another language. 

• Hyphenate text in another language. 

• Automatically correct text typed in another language. 

Formatting options for Japanese text   Special commands on the Format menu allow users to fit text 
to a specified width, set phonetic guides and enclose characters, combine characters to mix horizontal 
and vertical text in one line, and quickly switch between displaying hiragana and katakana characters 
as well as between half-width and full-width characters. Additional AutoFormat options for Japanese 
text allow users to automatically insert closings in memos and other documents. Users can select 
options in the Font dialog box (Format menu, Font command) to specify separate fonts for Asian and 
Latin text and set emphasis marks. 
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Searching for Japanese text   When finding and replacing text, Japanese find options (Word menu, 
Preferences command, Japanese Find) allow users to find text that sounds similar and to set specific 
character-matching options. Users can also set options to broaden or narrow the search for text in a 
document by treating some punctuation characters as identical. 

Setting display options for Japanese text   Users can use Japanese Typography (Word menu, 
Preferences command) settings to set Japanese typography options for kerning and character 
spacing, prevent certain characters from appearing at the start or end of lines of text, and set options 
for line breaks. 

Setting layout options for Japanese text   The Japanese Document Grid (Format menu, Document 
command, Document Grid tab) gives users control over whether to use a line grid or line and 
character grid to control formatting and the measurements for the grid. This enables users to enter 
characters by using fixed-pitch spacing (as in Genko or Gaozhi formatting). Users can also use the 
Document Grid to set the gutter at the left or top of the document (the default is left) and to set the 
document to print two full-scale pages on one sheet of paper to make booklets. Options on the 
Indents and Spacing tab (Format menu, Paragraph command) allow users to automatically adjust 
the right indent to fit the document grid and snap paragraphs to the grid as well as to set the 
paragraph alignment to distribute text. 

International features of Excel 2004 
Add phonetic guides   Users can add phonetic guides to Japanese data that has been entered in a 
cell. The phonetic character string that was used to enter the Japanese data is used to apply phonetic 
guides. To display the phonetic guides on the screen, point to Phonetic Guide on the Format menu, 
and then click Show Phonetic Fields. 

Modify phonetic guides   If the displayed phonetic guides are incorrect, users can revise them. Select 
the cell that shows the incorrect phonetic guides. To revise phonetic guides, on the Format menu, 
point to Phonetic Guide, and then click Edit. Users can now change the phonetic guides by using the 
same method they use to enter a character string. 

Change phonetic guide formats   Users can change the type, alignment, and font of phonetic guides. 
The three types of phonetic guides available are hiragana, full-width katakana, and half-width 
katakana. Their default alignment is left (that is, placed along the left edge of the kanji to which the 
phonetic guides apply). Users can change the alignment to no alignment (all phonetic guides are 
combined and aligned along the left edge of the cell), center alignment (centered against the kanji to 
which the guides apply), or distributed alignment (set with equal spacing against both edges of the 
kanji to which the guides apply). To change the type, alignment, or font of phonetic guides, point to 
Phonetic Guide on the Format menu, and then click Settings. 

Sort data by using phonetics   When worksheet data is sorted, Japanese data is sorted by its 
phonetic guides by default. If the correct phonetic guides have been used on characters that use 
them, Japanese terms are sorted in the same order as they would occur in a Japanese dictionary. 
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Automatic currency selection   Currency formats use the yen as the default monetary unit when an 
Office application is registered with the Microsoft Language Register for use with the Japanese 
language. 

Language-specific custom lists   Excel provides custom lists appropriate to each of the supported 
languages. For example, lists of the names of the days of the week and of the months are determined 
by the language settings in Mac OS X system preferences. To choose a set of custom lists for a 
particular region, users must choose the corresponding date and number formats on the 
International preference pane in System Preferences (Apple menu). 

Euro Conversion in Excel 2004   Like all Office 2004 applications, Excel enables users to enter, 
display, and print the euro symbol. Excel 2004 also provides extensive support for financial 
calculations involving euro values through the Euro Currency Tool add-in (Tools menu, Add-ins 
command). The Excel 2004 Formatting toolbar also includes a Euro Style button for formatting cells 
in euro currency style. 

The Euro Currency Tool add-in provides the EUROCONVERT function, which can convert a number to 
euros, convert from euros to a euro member currency, or convert from one member currency to 
another by using the euro as an intermediary. The currencies available for conversion are those of 
European Union members that have adopted the euro. The EUROCONVERT function uses fixed 
conversion rates that are established by the European Union. 

The EUROCONVERT function supports the following euro member countries and currencies: 

ISO code Calculation precision Display precision 

BEF 0 0 

LUF 0 0 

DEM 2 2 

ESP 0 0 

FRF 2 2 

IEP 2 2 

ITL 0 0 

NLG 2 2 

ATS 2 2 

PTE 1 2 

FIM 2 2 

GRD 0 2 

EUR 2 2 

 

For more information about euro currency conversion in Excel, see Excel Help. 
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Configuring Office 2004 for multiple languages 
To enable support for international features in the English version of Office 2004, users must 
configure their computers to recognize the language they want to use and the proofing tools for the 
language must be installed. 

Enabling Japanese-specific formatting and editing features 
Japanese language support is available for users of the English language version of Office 2004 when 
the Microsoft Language Register is used to register the applications for use with the Japanese 
language. 

By using the Microsoft Language Register, users can enable Japanese features in a number of 
Office 2004 applications. Users can enable Japanese features by dragging a specific Office program 
file to the Microsoft Language Register file, located in the Microsoft Office 2004/Additional Tools 
folder. They should then follow the instructions in the dialog box that appears. To enable Japanese 
features completely, users must register the following Microsoft Office programs: Excel, Word, 
Entourage, PowerPoint, Graph, Organization Chart, Clip Gallery, Equation Editor, and Office 
Notifications. 

Enabling European language features 
European language support is available when one or more keyboard layouts for supported European 
languages are enabled on the Keyboard Menu tab on the International pane in System Preferences 
(Apple menu, System Preferences command). To switch between languages, users can select the 
appropriate keyboard layout. For more information about setting a keyboard layout, see Mac Help. 

European language features in the English version of Office 2004 can also be enabled by installing 
Office 2004 on a version of the Mac OS for a supported language. 

International proofing tools 
Proofing tools for the supported languages are located in the Microsoft Office 2004/Shared 
Applications/Proofing Tools folder. 
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